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Những khái niệm cơ bản 
Hệ điều hành 

ột chương trình làm nhiệm vụ điều khiển các thiết bị và tổ chức giao tiếp giữa người và máy tính gọi là hệ 
điều hành-Operating System 

 

Hệ điều hành Windows  
Hệ điều hành đầu tiên của hãng Microsoft là MS-DOS được phát triển vào những năm 80 
của thế kỷ 20 với giao tiếp giữa người với máy tính bằng cách gõ câu lệnh nên không tiện 
dụng. Hệ điều hành Windows được đưa ra thị trường vào đầu những năm 90 đã phát triển 
theo ý tưởng giao tiếp người-máy qua các cửa sổ chứa biểu tượng nên người dùng có thể dễ 
dàng thao tác bằng bàn phím hay chuột máy tính. Ngoài ra hệ điều hành Windows có chức 
năng đa nhiệm nghĩa là quản lý nhiều chương trình ứng dụng đang hoạt động vì thế người 
dùng không cần đóng chương trình đang làm việc khi mở một cửa sổ chương trình khác. Kể 
từ khi giới thiệu Hệ điều hành Windows 95, sản phẩm của công ty Microsoft nhanh chóng 
được nhiều người sử dụng lựa chọn. Các sản phẩm tiếp theo Windows 95 là Windows 98, 
Windows, Windows XP và Windows Vista tính đến năm 2007. 

Windows XP Professional là hệ điều hành cài đặt cho máy tính văn phòng và gia đình. 
Windows 2003 Server là hệ điều hành cài đặt cài đặt cho các máy phục vụ dịch vụ của các 
công ty, cơ quan,... 

Đăng nhập vào máy tính 
Người sử dụng phải có một tài khoản (tiếng Anh là Account) gồm phần tên (user name) và 
mật khẩu (password) để đăng nhập vào hệ thống Windows XP. Đây là chức năng bảo mật 
mà hệ điều hành Windows 9x không có. 

Thực hành đăng nhập theo hình minh họa 

 + Nhấn tổ hợp phím Ctrl + Alt + Del  làm xuất hiện hộp thoại Windows Security 

 

Chương 
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 + Nhấn nút Log Off để làm xuất hiện hộp thoại đăng nhập -Log On to Windows 

 
Nhập tên tài khoản vào ô User name và nhập mật khẩu vào ô Password. Cuối cùng nhấn 
nút OK.  

Từ các phiên bản hệ điều hành Windows, Windows XP và Windows Vista có chức năng cho 
phép tự đăng nhập vào hệ thống theo một tài khoản đã tạo. Trong trường hợp đó người dùng 
không thấy xuất hiện cửa sổ yêu cầu việc đăng nhập hệ thống. 

Tắt /khởi động máy tính  
Tắt máy tính đúng cách 

+ Nhấn nút Start ở góc dưới, bên trái màn hình     

+ Chọn mục Shutdown.  

Trong các lựa chọn của hộp thoại “What do you want the computer to do”, khi chọn “Shut 
down” hệ điều hành đóng tất cả các cửa sổ ứng dụng và có thể điều khiển tắt luôn nguồn 
điện của máy; khi chọn "Log off" hệ điều hành đóng các ứng dụng và trở lại màn hình đăng 
nhập; khi chọn "Restart" hệ điều hành thực hiện đóng các ứng dụng và cho máy tính khởi 
động lại hệ điều hành mà không cần tắt nguồn điện của máy. 

 
Hình: Thao tác tắt máy tính 



 

W-6 

 
Hình: Lựa chọn để tắt máy tính. 

Tắt máy tính theo kiểu áp đặt 

+ Bấm tắt nguồn điện bằng cách nhấn nút POWER trên hộp máy (có thể phải giữ tay trên 
nút khoảng 1 phút). Chờ 30 giây trước khi bật lại nguồn điện cho máy.      

+ Việc tắt máy tính theo kiểu áp đặt chỉ nên dùng trong tình huống không thể dùng phím và 
chuột để điều khiển được hệ điều hành. 

Khởi động lại máy tính 

Trong quá trình làm việc, do lỗi của một số chương trình phần mềm hoặc lỗi thao tác của 
người sử dụng, máy tính có thể bị treo. Để xử lý trường hợp này, cách thông thường nhất là 
khởi động lại máy tính, bắt đầu một phiên làm việc mới. 

   Cách 1: Nhấn tổ hợp phím Ctrl + Alt + Del, chọn mục Shutdown -> Restart 

   Cách 2: Nhấn nút Start -> Shutdown -> Restart -> OK 

   Cách 3: Nhấn nút Reset trên hộp máy 
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Màn hình nền - Desktop  
Màn hình nền Windows là cửa sổ đầu tiên của Hệ điều hành dành cho người sử dụng. Người 
dùng ra lệnh cho hệ điều hành bằng thao tác đơn giản qua việc thao tác với các biểu tượng 
sinh động. Thanh tác vụ (Task Bar) nằm ở chân màn hình nền. Đầu trái của thanh tác vụ có 
nút Start. 

 

Chương 
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tượng  
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(task bar) 
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Các thao tác cơ bản với chuột máy tính 
Kỹ thuật sử dụng chuột 

 
Nắm vững cách thức và mục đích sử dụng của từng thao tác sẽ giúp người dùng tiết kiệm 
thời gian, tăng hiệu quả làm việc với máy tính. 

Con trỏ chuột  Hình ảnh một mũi tên trên màn hình thay đổi vị trí theo 
thao tác di chuyển con chuột của người sử dụng 

Nhấn chuột   Cụm từ “nhấn chuột” có ý nghĩa là nhấn phím chuột 
trái một lần và thả phím. Cụm từ "nhấn chuột phải" là 
nói rõ cho việc sử dụng phím chuột phải.  

Nhấn đúp chuột  Nghĩa là nhấn và thả phím chuột trái hai lần liên tiếp, 
đòi hỏi bấm nhanh. 

Kéo di chuột  có ý nghĩa là nhấn phím chuột trái, giữ phím và di 
chuyển con trỏ chuột. Thả phím chuột khi kết thúc hành 
động. 

Thực hành chọn một biểu tượng  

Nhấn chuột lên biểu tượng My Computer. 

  

 
Hình. Biểu tượng ở trạng thái tự do 

 

 
Hình. Biểu tượng ở trạng  thái được chọn 

Thực hành mở một cửa sổ  
(1) Nhấn đúp chuột lên một biểu tượng hay nhấn chuột lên biểu tượng và bấm phím Enter.  

(2) Đóng cửa sổ bằng cách bấm vào nút dấu X trên cửa sổ hoặc bấm tổ hợp phím Alt-F4. 

Thực hành di chuyển biểu tượng  

Đầu tiên là chọn biểu tượng My Computer, kéo di chuột. Một hình ảnh của biểu tượng xuất 
hiện ở dạng nét mờ thể hiện vị trí di chuyển của biểu tượng.   

 

phím chuột trái  
phím chuột phải 
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Thực hành một lệnh trên hộp lệnh  

Đầu tiên là chọn biểu tượng My Computer, sau đó nhấn chuột phải làm xuất hiện hộp lệnh. 
Thực hiện di chuyển trỏ chuột trên hộp lệnh và đưa về lại mục lệnh Open. Nhấn chuột để 
thực hiện lệnh Open.  

Thao tác nhấn chuột trên hộp lệnh có ý nghĩa thực hiện một lệnh. 

 
Cuối cùng là đóng cửa sổ My Computer đã được mở bằng cách nhấn chuột lên nút có dấu x 

Làm quen với  thanh thực đơn Start  
Nhấn chuột vào nút Start làm xuất hiện  thanh 
thực đơn với các danh mục phân chia theo chủ đề 
cho phép người sử dụng dễ dàng ra lệnh cho máy 
tính. 

Mục Run: cho phép gõ lệnh.  

Mục Help: cho phép mở cửa sổ trợ giúp Help. 

Mục Search: cho phép mở chương trình tìm kiếm 
tệp tin, thư mục hoặc các máy tính trên mạng. 

Mục Settings: cho phép mở chương trình thao tác 
điều khiển, chỉnh sửa hệ thống.  

Mục Documents: cho phép mở các tệp tin được sắp 
xếp theo thời gian tạo lập.  

Mục Programs: cho phép mở các mục liên kết đến 
các chương trình ứng dụng đã được cài trên máy. 
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Thao tác với thực đơn lệnh 

Mục Run - cho phép gõ lệnh 
Nhấn chuột vào nút Start, chọn mục Run làm xuất hiện hộp thọai nhập lệnh. Ví dụ gõ lệnh 
"calc" để mở bảng tính số học. 

 
Mục Help - mở phần trợ giúp 

Phần trợ giúp rất cần thiết khi sử dụng Windows nhưng đòi hỏi người sử dụng phải biết tiếng 
Anh. Để sử dụng phần Trợ giúp, nhấn chuột vào nút Start, sau đó chọn mục Help: 

 
 Đọc các hướng dẫn trợ giúp theo nội dung chủ đề (Pick a Help Topic), 

câu hỏi hỗ trợ (Ask for assistance)  hoặc tìm theo một  nhóm từ nào đó 
(Search). 

 Để tìm trợ giúp theo một thao tác nào đó, nhấn Pick a Task và lựa chọn 
dần theo nội dung hiện ra trong khung. 

 Để tìm trợ giúp theo nội dung của một từ hay cụm từ, nhấn trang Search 
và gõ từ hoặc cụm từ liên quan đến nội dung tìm kiếm vào ô. 

nhập lệnh 
vào ô này 
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Mục Search - hỗ trợ tìm kiếm thông tin trên máy 

Nhấn chuột vào nút Start, chọn mục Search -> For Files or Folders làm xuất hiện hộp 
thoại hỗ trợ tìm kiếm. 

  
Mục Settings - hỗ trợ quản trị hệ thống 
Nhấn chuột vào nút Start, chọn mục Settings -> chọn các mục con như Control Panel, 
Printers.. 

 
Mục Program- danh mục chương trình  

Nhấn chuột vào nút Start để hiển thị thanh thực đơn. Di chuyển con trỏ đến dòng chữ 
Program để hiển thị hộp lệnh con. Di chuyển con trỏ chuột đến mục lệnh chương trình. 

 
Dấu mũi tên hình tam giác bên phải xuất hiện trên mỗi danh mục cho biết có hộp lệnh con 
xuất hiện khi di chuyển con trỏ đến danh mục này. 

Khi xuất hiện mũi tên kép ở bảng danh mục, người sử dụng bấm vào mũi tên kép để hiển thị 
phần nội dung đang bị che dấu.   

☯ Thực hành việc mở chương trình máy tính số học 
+ Nhấn nút Start, chọn mục Program--> Accessories--> Calculator. Nhấn chuột tại mục 
Calculator để mở chương trình máy tính số học.     
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Khái niệm về ổ đĩa, tệp tin và thư mục 
Ổ đĩa vật lý và ổ đĩa logic 

Máy tính lưu kết quả xử lý trên các bộ nhớ ngoài gồm: đĩa mềm, đĩa cứng, đĩa quang, đĩa 
quang từ,... Để người dùng thao tác được với các thiết bị lưu trữ vật lý, một ổ đĩa cứng vật lý 
có thể được hệ điều hành phân chia thành nhiều vùng khác nhau gọi là ổ đĩa logic. Mỗi ổ đĩa 
logic được đặt tên theo một chữ cái.  

Chữ cái A - qui ước hình thức cho ổ đĩa mềm thứ nhất được cài trên máy và chữ cái B qui 
ước hình thức cho ổ đĩa mềm thứ hai (nếu có). 

Bắt đầu từ chữ cái C được qui ước hình thức cho các phân vùng ổ đĩa cứng của máy tính; ổ 
đĩa quang; ổ đĩa lưu trữ di động,...  

Tệp tin 

Trong hệ điều hành Windows, tệp tin là đối tượng chứa dữ liệu. Ví dụ các văn bản sau khi 
nhập vào máy được lưu thành các tệp tin để sau đó có mở ra xem lại, chỉnh sửa/in ấn và có 
thể xoá đi. 

Quy định chung về tên đầy đủ của mỗi tệp tin như sau: 

Têntệptin .  kiểutệptin 

Kiểu tệp tin còn được gọi là phần mở rộng. Chúng ta có thể xem qua một số kiểu tệp tin 
thông dụng sau: 

 
Phần mở rộng của tệp tin có vai trò rất quan trọng. Để hiểu được điều đó chúng ta cần nắm 
được qui tắc cơ bản về tệp tin như sau: 

Tệp tin được tạo ra bởi chương trình nào thì cần phải được mở ra để xem/chỉnh sửa bằng 
chính chương trình đó. 

Phần mở rộng trong tệp tin chính là thông tin quan trọng giúp hệ điều hành thực hiện đúng 
yêu cầu của tệp tin. Ví dụ khi nhấn đúp chuột lên tệp tin có tên là  festival2004.bmp  thì hệ 
điều hành ngầm hiểu là sử dụng chương trình MS-Paint để mở tệp này. Khi nhấn đúp chuột 
lên tệp tin congvan2004.doc thì hệ điều hành ngầm hiểu là sử dụng chương trình MS-Word 
để mở tệp này.  

Thư mục – Folder 

Để lưu giữ, sắp xếp các tệp tin thành một hệ thống phân cấp có tính chặt chẽ và tiện dụng khi 
tìm kiếm, hệ điều hành Windows cho phép người sử dụng xây dựng cây thư mục theo cách 
thức:  

 Ổ đĩa logic của máy tính được xác định là thư mục gốc. 

 doc, txt, rtf: Các tệp văn bản, thường được tạo ra từ 

các chương trình soạn thảo văn bản 

 exe, bat: Các tệp tin  chương trình 

 html, htm: Các tệp siêu văn bản 

 sql, mdb: Các tệp chứa cơ sở dữ liệu 

 mp3, dat, cda: Các tệp chứa âm thanh, video 

 gif, jpeg, bmp: Các tệp chứa hình ảnh 
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 Có thể tạo nhiều thư mục con trong thư mục 

 Tệp tin phải được chứa trong một thư mục  

 

 

 

 

 

 

 

 

Có thể hình dung hệ thống thư mục của Windows qua tủ đựng ngăn phiếu tra cứu sách tại 
thư viện. Tủ đựng ngăn phiếu là thư mục gốc, trong tủ sách có các ngăn chia nhỏ theo từng 
chủ đề đó là các thư mục con. Mỗi tấm phiếu là một tệp tin chứa thông tin tóm tắt về cuốn 
sách. 

TTêênn  ccủủaa  ttệệpp  ttiinn  vvàà  tthhưư  mmụụcc  
Tên tệp tin có hai phần: phần tên tự đặt và phần mở rộng.  

 Hệ điều hành cho phép đặt tên dài đến 225kí tự nhưng để dễ quản lý tệp tin 
chỉ nên đặt tên ngắn gọn, gợi nhớ đến nội dung chứa trong tệp tin (ví dụ: 
thongke_taisan_quy1.doc), không gõ tiếng Việt trong phần tên và nên sử 
dụng dấu nối giữa các cụm từ.  

 Phần mở rộng là phần do các chương trình tạo tệp tin tự động thiết lập.  

 Tên thư mục được đặt như tên tệp tin nhưng không cần đến phần mở rộng.  

Một số nhận xét 

 Các thư mục con cùng cấp không có tên trùng nhau. 

 Thư mục con có thể trùng tên với thư mục mẹ của nó. 

 Hai tệp tin chứa trong cùng một thư mục thì không có tên trùng nhau, nhưng 
khác thư mục thì có thể. 

 Một tệp tin phải chứa trong một thư mục nhưng không chứa đồng thời trong 
hai thư mục con cùng cấp. 

ĐĐưườờnngg  ddẫẫnn  cchhoo  ttệệpp  ttiinn    

Để diễn tả vị trí của tệp tin trong hệ thống thư mục chúng ta cần viết đường dẫn theo cách 
sau:   [ổ đĩa gốc:] [\] [<tên thư mục> \ ...\ <tên thư mục> \ <tên tệp tin>] 

Ví dụ: Đường dẫn C:\congvan2004\danhsachCB1.doc chỉ ra tệp tin danhsachCB1.doc 
đang được chứa trong thư mục congvan2004 thuộc ổ đĩa C. 

Thư mục gốc <tên ổ đĩa logic>

<tên thư mục con cấp 1> 

<tên tệp tin> 

<tên tệp tin> 

<tên thư mục con cấp 1> 

<tên thư mục con cấp 2> 
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Làm việc với biểu tượng 
Phân loại biểu tượng  

 

Biểu tượng đặc biệt của hệ điều hành   

+ Gồm biểu tượng My Documents, My 
Computer, My Network Places, Recycle 
Bin, Internet Explorer. 

+ Khi cài đặt xong hệ điều hành thì các 
biểu tượng này được tạo ra ngay trên màn 
hình chính. 

 

 

 

 Biểu tượng của thư mục  
+ Một thư mục được hệ điều hành 
Windows biểu diễn bằng một biểu tượng 
(tiếng Anh là Icon). Hình ảnh của biểu 
tượng là túi hồ sơ màu vàng như hình 
minh hoạ và tên biểu tượng xuất hiện bên 
dưới.  

Biểu tượng liên kết nhanh cho thư mục 
(hay gọi là nút bấm nhanh) 
+ Tiếng Anh gọi là Shortcut, có hình ảnh 
là túi hồ sơ màu vàng có thêm mũi tên ở 
góc dưới bên trái. 

 

 Biểu tượng của tệp tin  

+ Một tệp tin được hệ điều hành 
Windows biểu diễn bằng một biểu tượng. 
Biểu tượng của tệp tin rất đa dạng do mỗi 
tệp tin chương trình cần có 1 biểu tượng 
riêng. Ví dụ chương trình Notepad.EXE 
có biểu tượng là cuốn sổ ghi chép đang 
mở.  

Nút bấm nhanh đến tệp tin 
+ Có dấu mũi tên xuất hiện ở trên biểu 
tượng. 
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Tạo tệp tin, thư mục trên Desktop 

Để làm quen với tệp tin và thư mục, chúng ta hãy thực hiện tạo tệp tin/thư mục trên màn 
hình nền. 
TTạạoo  ttệệpp  ttiinn  đđơơnn  ggiiảảnn  

Bước 1: nhấn chuột phải trên màn hình nền  
làm xuất hiện hộp thoại. 

Bước 2: chọn mục New -->Text Document 

Tệp tin được tạo ra chỉ là một tệp tin rỗng 
chưa có nội dung gì bên trong. 

 

 

 

 

 

 

 

 
TTạạoo  tthhưư  mmụụcc  

Bước 1: nhấn chuột phải trên màn hình nền làm xuất hiện hộp 
lệnh. 

Bước 2: chọn mục New --> Folder 

Thực hành: 

Tạo ba thư mục mới, hai tệp tin mới trên màn hình nền.  

 

  
  
TTạạoo  nnúútt  bbấấmm  nnhhaannhh      

Ý nghĩa của nút bấm nhanh đó là rút ngắn thao tác cho người sử dụng.  

Thực hiện thao tác minh họa  

Chúng ta đã một lần thực hiện 
mở chương trình máy tính số 
học bằng cách  

+ Nhấn nút Start, chọn mục 
Program--> Accessories--> 
Calculator. Nhấn chuột trái tại 
mục Calculator để mở chương 
trình máy tính số học. 
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Theo cách làm trên người sử dụng phải thao tác chuột nhiều lần qua các thực đơn lệnh. 

Nếu thao tác không chính xác sẽ không mở được chương trình. Thực hiện tạo nút bấm nhanh 
đặt trên màn hình nền để mở chương trình chỉ bằng một lần bấm nút. 

+ Nhấn nút Start, chọn mục Program--> Accessories--> Calculator.  

+ Nhấn chuột phải tại mục Calculator để mở hộp lệnh. Chọn mục Send to --> Desktop 
(create shortcut). 

 
 
TTạạoo  nnúútt  bbấấmm  nnhhaannhh    

Hệ điều hành Windows cho phép tạo nút bấm nhanh 
(tên tiếng Anh là Shortcut) cho các biểu tượng mà 
chúng ta thấy trên màn hình.  
Cách thực hiện 
Bước 1: nhấn chuột phải trên biểu tượng làm xuất hiện 
thực đơn lệnh. 

Bước 2: di chuyển con trỏ về mục Create shortcut 

 

Lưu ý: Có thể đổi biểu tượng của nút bấm nhanh khi chọn mục Change Icon trong hộp thoại 
Properties của nút.  

ĐĐổổii    ttêênn  ccủủaa  bbiiểểuu  ttưượợnngg    
Cách thực hiện  
Bước 1: nhấn chuột phải lên biểu tượng làm xuất hiện 
hộp lệnh. 

Bước 2: chọn mục Rename. Sau đó gõ tên mới vào ô 
nhập. 

Lưu ý: khi đổi tên của tệp tin không nên thay đổi phần mở rộng của nó.  

Cách đổi tên đơn giản 

Chỉ cần nhấn chuột một lần vào phần tên của biểu tượng lập tức hệ điều 
hành cho phép gõ tên mới như hình minh họa.  
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SSắắpp  xxếếpp  vvịị  ttrríí  ccáácc  bbiiểểuu  ttưượợnngg  ttrrêênn  DDeesskkttoopp  
Cách thực hiện  

Bước 1: nhấn chuột phải lên màn hình nền 
làm xuất hiện hộp lệnh. 

Bước 2: chọn mục Arrange Icons -> Auto 
Arrange và nhấn chuột để chọn chức năng 
tự động sắp xếp. Nếu thực hiện điều này lần 
thứ hai thì chức năng Auto Arrange chuyển 
sang trạng thái không chọn.  

Các mục sắp xếp khác như 

* by Name - theo tên;  

* by Type - theo kiểu;  

* by Size - theo dung lượng nhớ;  

* by Date - theo ngày tháng tạo lập.  

 

Bài thực hành: Làm theo trình tự dưới đây 

(1) Tạo một thư mục mới 

(2) Tạo một nút bấm nhanh cho thư mục.  

(3) Tạo một nút bấm nhanh cho nút bấm nhanh đã tạo ở mục (2). 

(4) Tạo một tệp tin mới 

(5) Tạo một nút bấm nhanh cho tệp tin.  

(6) Tạo một nút bấm nhanh cho nút bấm nhanh đã tạo ở mục (5). 

(7) Tạo nút bấm nhanh cho My Computer. 
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Làm việc với  tệp tin và thư mục trên Desktop 
Chọn nhóm tệp tin, thư mục liền kề   

Thao tác bằng thiết bị chuột 
Kéo di chuột tạo một đường hình chữ nhật bao quanh các biểu tượng muốn chọn. Các biểu 
tượng được chọn đổi sang màu tối nên thao tác chọn được gọi nôm na là "bôi đen đối 
tượng". Khi tạo đường bao có thể dễ dàng phóng to hoặc thu nhỏ vùng chọn. 

 
Thao tác bằng bàn phím  
Bước 1: nhấn chuột chọn một biểu tượng của góc trên bên trái (hoặc góc dưới bên phải). 

Bước 2: Giữ phím Shift, bấm phím mũi tên qua trái/qua phải hoặc mũi tên đi lên trên/đi 
xuống dưới để mở rộng hoặc thu nhỏ vùng chọn. 

Thao tác kết hợp giữa chuột và bàn phím  
Bước 1: nhấn chuột chọn một biểu tượng của góc trên bên trái (hoặc góc dưới bên phải). 

Bước 2: Giữ phím Shift và nhấn chuột vào biểu tượng ở các góc vùng chọn. 

Chọn nhóm biểu tượng rời rạc  

Thao tác tượng tự như chọn nhóm biểu tượng liền kề, nhưng điểm quan trọng nhất phải làm 
đó là nhấn giữ phím Ctrl khi chọn các đối tượng. Có thể bấm chọn lần thứ hai trên một đối 
tượng để nhanh chóng hủy chọn chỉ riêng cho đối tượng đó. 

 

xuất hiện 
đường bao 
hình chữ nhật 
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Hủy chọn nhóm   

Nhấn chuột tại vị trí bất kỳ trên màn hình nền hoặc bấm một trong các phím mũi tên di 
chuyển con trỏ để hủy bỏ toàn bộ vùng chọn. 

Sao chép/dán tệp tin, thư mục  
Cách thực hiện  

Bước 1:  chọn biểu tượng hoặc nhóm biểu tượng. (không phân biệt tập tin hay thư mục)  

Bước 2: nhấn chuột phải lên vùng chọn làm xuất hiện hộp lệnh. Sau đó chọn mục Copy.  

 
Bước 3: thực hiện trong hai trường hợp 

Để sao chép và dán ngay trên màn hình nền, 
hãy nhấn chuột phải trên màn hình nền làm 
xuất hiện hộp lệnh và chọn mục Paste. 

Để sao chép và dán vào trong một thư mục 
đang có mặt trên màn hình nền, hãy nhấn 
chuột phải trên thư mục để làm xuất hiện hộp 
lệnh và sau đó chọn mục Paste. 
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Thao tác sao chép nâng cao: 

Cách thứ 1: 

- Đầu tiên là chọn nhóm biểu tượng 

- Nhấn tổ hợp phím Ctrl-C (tương đương với mục Copy) 

- Chọn nơi cần sao chép (là màn hình nền hay thư mục khác) 

- Nhấn phím Ctrl-V (tương đương với mục Paste) 

Cách thứ 2: 

- Đầu tiên là chọn nhóm biểu tượng 

- Giữ phím Ctrl và kéo di chuột nhóm biểu tượng đã chọn đến nơi cần sao chép. 

Di chuyển tệp tin, thư mục  

Việc di chuyển tệp tin, thư mục có hai trường hợp 

Vị trí đích đến là Desktop 
Cách thực hiện  
Bước 1:  chọn biểu tượng hoặc nhóm biểu 
tượng. (không phân biệt tập tin hay thư mục) 

Bước 2: nhấn giữ chuột trên vùng chọn, kéo 
di chuột đưa vùng chọn đến vị trí khác.  

Vị trí đích đến là một thư mục   
Cách thực hiện  
Bước 1:  chọn biểu tượng hoặc nhóm biểu 
tượng. (không phân biệt tập tin hay thư mục) 

Bước 2: nhấn giữ chuột trên vùng chọn, kéo 
di chuột đưa vùng chọn đến thư mục đích. 

  

Lưu ý: việc di chuyển tự do biểu tượng trên 
màn hình nền-Desktop phụ thuộc vào mục 
Auto Arrange có được kích hoạt hay không.  

Hình trên minh họa việc di chuyển tệp tin 
Image12 và hai thư mục đến thư mục có tên 
là congvan 

 

Hiển thị thông tin của tệp tin, thư mục  
Cách thực hiện  

Bước 1: nhắp chọn nhóm biểu tượng.  

Bước 2: kích chuột phải làm xuất hiện hộp lệnh, chọn mục Properties. 
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Thông tin của tệp tin, thư mục xuất hiện trong hộp Properties cho người dùng biết số lượng 
tệp tin, thư mục và quan trọng nhất là tổng dung lượng nhớ (ví dụ theo hình minh họa là 
35.2MB). Điều đó giúp cho người dùng có quyết định chính xác khi muốn sao chép tệp tin, 
thư mục lên các thiết bị lưu trữ thường sử dụng như đĩa mềm, thẻ nhớ tiện dụng Flash 
Memory, đĩa CDROM,... 
Đặt thuộc tính chỉ đọc (read-only)  

Trong hộp thoại Properties, nhấn chọn ô Read-only để đặt thuộc tính chỉ đọc/cấm xóa cho 
tệp tin hay thư mục và nhấn chọn ô Hidden để đặt thuộc tính che dấu cho tệp tin hay thư 
mục.  

 
 

☯ Thực hành 

Thao tác hiển thị thuộc tính cho một tệp tin, một thư mục, nhóm tệp tin, nhóm thư mục. 

Xóa tệp tin hoặc thư mục  
Cách thực hiện  

Bước 1:  chọn biểu tượng hoặc nhóm biểu tượng (không phân biệt liền kề hoặc rời rạc).  

Bước 2: bấm phím Delete để xóa. Các tệp tin, thư mục bị xóa được đưa vào một thư mục của 
hệ thống có tên gọi là Recycle Bin (gọi theo tiếng Việt là thùng rác).  

Biểu tượng của thùng rác trên màn hình nền 

 

thùng rác rỗng 
 

thùng rác đang chứa  
tệp tin hoặc thư mục đã bị xóa 

Lưu  ý: Nếu dùng tổ hợp phím Shift-Del để thực hiện xóa thì tệp tin, thư mục mất hẳn không 
lưu trung gian trong thùng rác.   
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Mở tệp tin   
Cách thực hiện  

Cách 1:  nhấn đúp lên biểu tượng tệp tin. 

Cách 2: nhấn chuột phải trên biểu tượng tệp tin làm xuất hiện hộp lệnh.  

Có hai lệnh để chọn: 

- lệnh Open: có chức năng mở tệp tin bằng chương trình đã được đăng ký với hệ điều hành. 
Ví dụ: tệp tin  congvan.doc được đăng ký là mở bằng chương trình soạn thảo văn bản MS-
Word. Việc đăng ký này được thực hiện tự động khi chúng ta cài đặt chương trình soạn thảo 
MS-Word. 

- lệnh Open with: có chức năng mở tệp tin bằng chương trình tự chọn trong hộp thoại như 
hình minh họa sau 

 
Theo hình minh họa, tệp tin congvan có thể được mở bằng chương trình Notepad hoặc  
Internet Explorer. Nếu muốn mở tệp tin bằng chương trình khác nữa khi chọn mục lệnh 
Choose Program... làm mở tiếp hộp thoại Open With 

 
Chọn một chương trình mở tệp và nhấn nút OK. 

Lưu ý: Nếu nhấn chọn mục Alway use this... chính là đăng ký lại với hệ điều hành về chương 
trình mở tệp cho nên mục này  để nguyên ô trống là tốt nhất.  
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Hộp lệnh của màn hình nền - Desktop 
Nhấn chuột phải trên màn hình nền sẽ làm xuất hiện hộp lệnh cho phép người sử dụng điều 
khiển màn hình. Hình minh họa của hộp lệnh của màn hình nền như sau: 

 
- Nhóm lệnh Active Desktop: 

 
Theo hình minh họa, mục Show Desktop Icons đang ở trạng thái được chọn và biểu thị bằng 
dấu  ở phía bên trái. Nếu chúng ta đưa trỏ chuột đến mục này và nhấn chuột có nghĩa là ra 
lệnh cho hệ điều hành đặt mục Show Desktop Icons về trạng thái không được chọn. Khi mục 
này không được chọn, tất cả các biểu tượng trên màn hình nền bị che dấu. 

Để đặt mục Show Desktop Icons trở về trạng thái được chọn, chúng ta thao tác lại việc đưa 
trỏ chuột đến mục này và nhấn chuột.  

- Nhóm lệnh Arrange Icons: 

 
cho phép sắp xếp các đối tượng trong cửa sổ theo các mục: 

* By name: sắp theo tên. 

* By Type: sắp theo kiểu hay là phần mở rộng của tên tệp. 

* By size: sắp theo dung lượng nhớ. 

* By date: sắp theo ngày tháng khởi tạo/chỉnh sửa đối tượng thành 

* Auto Arrange: có nghĩa là tự động sắp xếp.  

Theo hình minh họa thì mục Auto Arrange đang ở trạng thái không được chọn. Để đặt mục 
Auto Arrange về trạng thái được chọn, chúng ta đưa trỏ chuột đến mục này và nhấn chuột.  

 
Khi mục Auto Arrange ở trạng thái được chọn thì việc di chuyển các biểu tượng sẽ rất khó 
khăn vì chúng luôn được tự động sắp xếp. 
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- Lệnh Line Up Icons:  

có ý nghĩa là sắp xếp các biểu tượng trên màn hình nền có hàng có lối 

 

hình ảnh trước khi thực hiện 

lệnh Line Up Icons 

hình ảnh sau khi thực hiện lệnh 

 

- Lệnh Refresh (gọi là làm tươi):  
có ý nghĩa cập nhật thông tin mới nhất. 

- Lệnh Paste  (gọi là dán):  
có ý nghĩa sao chép nội dung đã được tạo ảnh bằng lệnh Copy (gọi là sao chép) hay lệnh Cut 
(gọi là cắt) lên màn hình nền. 

- Lệnh Paste  Shortcut (gọi là tạo nút bấm nhanh):  

có ý nghĩa tạo nút bấm nhanh trên màn hình nền cho nội dung đã được tạo ảnh bằng lệnh 
Copy (gọi là sao chép) hay lệnh Cut.  

- Nhóm lệnh New: 

 
* Mục lệnh Folder: cho phép tạo thư mục mới. 

* Mục lệnh Shortcut: cho phép tạo nút bấm nhanh trên màn hình nền cho các đối 
tượng bất kỳ như tệp tin, thư mục,...  

* Mục lệnh Briefcase: cho phép tạo đối tượng mới là Briefcase. Có thể gọi tên là túi 
hồ sơ cập nhật. Đối tượng này được sử dụng cho mục đích đồng nhất nội dung của 
hai thư mục trong quá trình cập nhật.   

biểu tượng của 
Briefcase 
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nội dung chứa trong 
Briefcase 

 

hộp thọai xuất hiện khi 
muốn đồng nhất nội 
dung giữa thư mục 
gốc và túi hồ sơ cập 

nhật  

 

- Lệnh Properties:  
cho phép mở hộp thoại để người dùng xem thông tin và chỉnh sửa các thuộc tính của màn 
hình nền. 

 
Chúng ta sẽ làm việc chi tiết với hộp thoại này trong phần trình bày về cửa sổ Control Panel.  
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Làm việc với cửa sổ 
Có thể xem màn hình nền là một cửa sổ đặc biệt của hệ điều hành Windows. Bây giờ chúng 
ta tiếp tục tìm hiểu thêm về các cửa sổ, một đối tượng mà người sử dụng thường thao tác. 

Mở cửa sổ  

Có hai cách làm xuất hiện cửa sổ: 

Cách 1: Nhấn đúp chuột lên biểu tượng trên màn hình nền-Desktop. Thao tác nhấn đúp 
chuột có thể thay bằng thao tác chọn biểu tượng và nhấn phím Enter. 

Cách 2: Nhấn nút Start. Sau đó chọn các mục lệnh trong thanh thực đơn Start và trong các 
hộp lệnh con của nó. 

Các thành phần và tính chất chung của cửa sổ  
Nhấn chuột trên biểu tượng My Computer trên màn hình nền để mở cửa sổ My Computer. 
Một cửa sổ có các thành phần sau: 

-  Thanh tiêu đề nằm phía trên cửa sổ. Nhấn đúp chuột trên thanh tiêu đề sẽ làm cho thanh 
tiêu đề thay đổi kích cỡ hiển thị. 

- Dưới thanh tiêu đề là thanh thực đơn lệnh, chứa thực đơn lệnh FILE, EDIT,... Tất cả các 
lệnh điều khiển cửa sổ và các đối tượng khác trong cửa sổ đều có mặt trong thanh thực 
đơn lệnh. 

- Thanh công cụ chứa các nút bấm nhanh liên kết đến các chức năng. Thay cho việc chọn 
lựa lệnh trong thanh lệnh, người sử dụng sẽ thao tác nhanh hơn khi sử dụng nút chức năng 
tương đương trên thanh công cụ. 

 

 
- Tại góc trên, bên phải cửa sổ có các nút: 

 - nút thu nhỏ cửa sổ. Chỉ còn một nút bấm nhanh trên thanh tác vụ cho 
phép mở lại cửa sổ.  

 - nút chức năng phóng to cửa sổ chiếm toàn bộ màn hình;  

 - nút biến đổi cửa sổ về trạng thái có thể co giãn được.  

 - nút đóng cửa sổ. 

 

Thanh tiêu đề 

Các thanh công cụ 

 ổ đĩa logic C - thư mục gốc 

Thư mục Control Panel 

Thanh thực đơn lệnh 

 ổ đĩa A  

nền cửa sổ
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- Thanh cuộn ngang sẽ tự động xuất hiện ở dưới đáy cửa sổ khi một phần nội dung trong cửa 
sổ bị che khuất. Nhấn chuột vào biểu tượng  hoặc  để di chuyển nội dung sang trái hoặc 
phải. 

- Thanh trạng thái là nơi hiển thị thông tin quan trọng về các đối tượng được chọn trong cửa 
sổ. 

- Đường biên là đường viền mảnh bao quanh các cửa sổ ứng dụng. Đường biên giới hạn 
phạm vi cửa sổ, phân biệt phần nội dung bên trong và bên ngoài cửa sổ. Có 2 loại: đường 
biên dọc và đường biên ngang.  

 

Đưa con trỏ chuột về vị trí bất kỳ trên đường biên dọc, biểu tượng 
con trỏ chuột chuyển sang hình mũi tên  

Nhấn giữ phím chuột trái rồi kéo dãn hoặc thu nhỏ cửa sổ theo chiều 
ngang 

Đưa con trỏ chuột về vị trí bất kỳ trên đường biên ngang, biểu 
tượng con trỏ chuột chuyển sang hình mũi tên  

Nhấn giữ phím chuột trái rồi kéo dãn hoặc thu nhỏ cửa sổ theo chiều 
dọc 

Đưa con trỏ chuột về góc biên. Biểu tượng con trỏ chuột chuyển 
sang hình mũi tên  

Nhấn giữ phím chuột trái rồi kéo dãn hoặc thu nhỏ cửa sổ theo 2 
chiều dọc và ngang 

Co dãn cửa sổ theo 
chiều ngang 

Co dãn cửa sổ theo 
chiều dọc 

Co dãn cửa sổ từ góc
biên 

Đường biên dọc 

Đường biên ngang 
Góc biên  

thanh trạng thái 

thanh cuộn ngang 
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- Các lệnh điều khiển cửa sổ:  

• Restore: Khôi phục cửa sổ về kích thước trước đó. Chỉ có ý nghĩa khi cửa sổ đang ở 
chế độ cực đại hoặc cực tiểu. 

• Move: Di chuyển cửa sổ đến vị trí mới. 

• Size: Định lại kích thước của cửa sổ hiện hành. 

• Minimize: Thu nhỏ cửa sổ thành biểu tượng dưới thanh tác vụ. 

• Maximize: Phóng to cửa sổ chiếm toàn bộ màn hình. 

• Close: Đóng cửa sổ hiện hành. 

Di chuyển giữa nhiều cửa sổ  

Mở ba cửa sổ để thực hành thao tác: My Computer, Recycle Bin, một cửa sổ thư mục bất kỳ. 

 

 

 

nút biểu tượng cửa sổ 

các lệnh điều khiển 
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(1) Sử dụng nút Maximize để phóng to các cửa sổ đầy màn hình, sử dụng nút Minimize để 
thu nhỏ từng cửa sổ thành nút bấm nhanh trên thanh tác vụ; sử dụng nút Restore Down để 
đưa các cửa sổ về dạng có thể thay đổi kích cỡ. 

(2) Nhấn chuột vào nút bấm nhanh trên thanh tác vụ để mở lại các cửa sổ. 

 
(3) Chuyển điều khiển lần lượt qua các cửa sổ bằng cách nhấn chuột lên thanh tiêu đề. 

(4) Chuyển điều khiển lần lượt qua các cửa sổ bằng tổ hợp phím Alt-Tab. 

 
(5) Nhắp chuột phải trên thanh tác vụ làm xuất hiện hộp lệnh. Thu nhỏ tất cả cửa sổ cùng 
một lượt bằng cách nhấn chọn mục Minimize All Windows. 

 
 

Hộp lệnh của thanh tác vụ - task bar 
Nhấn chuột phải trên phần nền của thanh tác vụ làm xuất hiện hộp lệnh. 

 

hộp lệnh của 
thanh tác vụ  

thanh tác vụ 
- Taskbar 
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- Nhóm lệnh View:  

 
cho phép chọn cách hiển thị các nút trên thanh tác vụ theo kích cỡ Large (là cao lớn) và 
Small (là cỡ bé như bình thường đang có). 

- Lệnh Show Text: cho phép đặt trạng thái chọn Show Text - là trạng thái các biểu tượng trên 
thanh tác vụ có dòng chữ đi kèm. 

mục Show Text được chọn hình ảnh của biểu tượng có dòng chữ đi kèm 

  

- Lệnh Refresh: có ý nghĩa cập nhật thông tin cho thanh tác vụ. 

- Lệnh Open: có ý nghĩa mở cửa sổ quản lý các biểu tượng trên thanh công cụ Quick 
Launch. 

 
- Lệnh Show Title: cho phép hiển thị tên các thanh công cụ có trên thanh tác vụ. Ví dụ dòng 
chữ Quick Launch xuất hiện trong hình minh họa 

 
- Nhóm lệnh Toolbars: 

Trên thanh tác vụ có thể mở nhiều thanh công cụ để làm việc. Có thể mở hoặc đóng bớt các 
thanh công cụ qua nhóm lệnh Toolbars. 

 
Cách thao tác để đặt trạng thái chọn và không chọn là thao tác chúng ta đã thực hiện nhiều 
lần qua các nội dung trước. 

Mặc dù có thể chọn nhiều thanh công cụ đặt trên thanh tác vụ nhưng chúng ta chỉ nên chọn 
một thanh công cụ đó là thanh Quick Launch, còn các thanh khác nên che dấu đi vì  khoảng 
trống trên thanh tác vụ không có nhiều.  
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- Thanh công cụ Quick Launch: 

Đây là một tiện ích không thể bỏ qua đối với người sử dụng. Thanh công cụ này chứa một số 
nút sẵn có rất cần thiết đó là: 

 

* Nút Show Desktop:    

cho phép mở ngay màn hình nền cho dù chúng ta đang làm việc với bất kỳ cửa sổ nào. 

* Nút bấm nhanh tự tạo: 

người sử dụng có thể tạo nút bấm nhanh cho bất cứ chương trình nào và đặt nút lên ngay trên 
thanh công cụ này với các bước làm như sau: 

Bước 1: tạo nút bấm nhanh cho chương trình và đặt trên màn hình nền 

Bước 2: kéo nút bấm nhanh mới tạo từ trên màn hình nền xuống thanh công cụ Quick 
Launch.  

Ví dụ như nút  có mặt trên hình minh họa là nút bấm nhanh cho chương trình gõ tiếng 
Việt Unikey. 

- Lệnh Adjust Date/Time: cho phép mở hộp thọai Date/Time Properties để hiệu chỉnh đồng 
hồ máy tính. 

 
Thẻ Date&Time cho phép chỉnh sửa ngày/tháng/năm và giờ. Thẻ Time Zone cho phép chỉnh 
múi giờ đúng theo múi giờ của Việt Nam. 

- Lệnh Cascade Windows cho phép sắp xếp các cửa sổ đang mở theo dạng mái ngói  

 
 



 

W-32 

- Lệnh Tile Windows Horizontally và Tile Windows Verticaly: cho phép xếp các cửa sổ dàn 
ngang trên màn hình nền, không có cửa sổ bị che lấp 

- Lệnh Minimize All Windows: cho phép thu nhỏ tất cả các cửa sổ đang mở cùng một lần. 

- Lệnh Task Manager: cho phép mở cửa sổ quản lý chương trình -Windows Task Manager  

 
Trong thẻ Applications của cửa sổ này, người sử dụng có thể chọn một chương trình hay 
nhiều chương trình và ra lệnh đóng chương trình. Đây là chức năng rất tiện ích cho việc 
đóng những chương trình đang gây tắc nghẽn hệ thống. 

- Lệnh Properties: cho phép mở hộp thoại 

 
Lưu ý: có thể mở hộp thoại này theo cách khác như sau: nhấn nút Start -> Settings -> 
Taskbar & Start Menu . 
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Thẻ General của hộp thọai Taskbar and Start Menu 

* Mục Always on top: thiết lập thuộc tính làm cho thanh trạng thái luôn nổi. Có nghĩa là khi 
mở một cửa sổ bất kỳ theo kiểu phóng lớn cả màn hình chúng ta vẫn nhìn thấy thanh tác vụ 
ở phía dưới chân cửa sổ. Đây là tính chất rất tiện ích nên chúng ta nên để trạng thái chọn 
trong ô kiểm.   

* Mục Auto hide: thiết lập thuộc tính làm cho thanh trạng thái được tự động che dấu khi  
chúng ta không di chuyển con trỏ lên thanh. 

* Mục Show small icons in Start menu: thiết lập thuộc tính hiển thị các biểu tượng trên thanh 
thực đơn Start ở kích cỡ nhỏ. 

* Mục Show clock: thiết lập việc hiển thị đống hồ máy  tính ở góc bên phải của thanh tác vụ 
hay không. 

* Mục Use Personalized Menus: thiết lập thuộc tính che dấu bớt các mục lệnh chưa dùng 
trên thanh thực đơn. Khi thao tác người sử dụng có thể bấm vào mũi tên >> để mở rộng nội 
dung của thanh lệnh. 

 
Thẻ Advanced của hộp thọai Taskbar and Start Menu 

 
* Nút Clear: cho phép xóa danh sách các ghi nhận tên văn bản, chương trình và địa chỉ trang 
web làm việc. Chúng ta có thể xem danh sách này trong mục Documents của thanh thực đơn 
lệnh.  
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hình minh họa  

mục Documents trước khi bấm nút Clear để xóa 

hình minh họa  

mục Documents sau khi xóa 

 

* Nút Add: cho phép thêm nội dung liên kết trong thanh thực đơn Start. 

* Nút Remove: cho phép xóa bớt nội dung trong thanh thực đơn Start. 

* Nút Advanced...: cho phép thêm nội dung liên kết trong cửa sổ Start menu. 

* Nút Re-sort: cho phép sắp xếp các mục nội dung thực đơn Start. 

Trong phần Start Menu Settings 

* Nhấn chọn hộp kiểm tại mục Display Logoff  

 
để làm xuất hiện thêm mục Log Off administrator... trên thanh thực đơn Start như hình minh 
họa dưới đây: 

 
- Lệnh Close trên hộp lệnh dùng để đóng hộp lệnh. 
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Cửa sổ My Computer   
Sử dụng thanh công cụ 

Khi Windows đã sẵn sàng làm việc, nhấn đúp vào biểu tượng My computer trên màn hình 
nền để mở cửa sổ My Computer. Cửa sổ My Computer hiển thị các biểu tượng ổ đĩa và thư 
mục Control Panel.  

 
Nhấn đúp chuột lên mỗi biểu tượng ổ đĩa trong cửa sổ My Computer sẽ mở ra cửa sổ thư 
mục cho phép người sử dụng quản lý tệp tin và thư mục trên ổ đĩa. 
 
TThhaannhh  ccôônngg  ccụụ  ccơơ  bbảảnn  --  SSttaannddaarrdd  BBuuttttoonnss  

- Nhấn nút  để quay trở về cửa sổ thư mục đã xuất hiện trước thời điểm hiện tại . 

- Nhấn nút  để làm xuất hiện cửa sổ có trước khi bấm nút Back. 

- Nhấn nút  để chuyển lên thư mục mẹ của thư mục hiện hành. 

- Nhấn nút   làm xuất hiện cửa sổ tìm kiếm thông tin (Search). Nhấn lần thứ hai để 
đóng cửa sổ. 

- Nhấn nút   làm xuất hiện cửa sổ cây thư mục. Nhấn lần thứ hai để đóng cửa sổ. 

Khi chuyển sang cửa sổ thư mục  sẽ có những nút sau được sử dụng 

- Nhấn nút   để di chuyển thư mục được chọn. 

- Nhấn nút   để sao chép thư mục được chọn. 

- Nhấn nút   để xóa thư mục được chọn. 

- Nhấn nút   để trở về trạng thái cũ. Nếu thao tác xóa thư mục đã xảy ra và thư mục 
được đưa vào thùng rác thì nhấn nút này để thư mục trở về lại trạng thái chưa bị xóa.  

Chương 

3
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Khi cửa sổ bị thu hẹp, một số nút trên thanh công cụ bị che dấu. Dấu mũi tên  >>  cho phép 
hiển thị các nút bị che dấu. 

 
Thực hiện nhấn chuột lên dấu mũi tên làm xuất hiện nút Views bị che dấu. Trong hộp lệnh 
View có thể chọn các cách hiển thị tệp tin, thư mục trong cửa sổ: 

- Mục Large Icons: khi chọn mục này, cửa sổ hiển thị biểu tượng theo kích thước lớn. 

- Mục Small Icons: khi chọn mục này, cửa sổ hiển thị biểu tượng theo kích thước bé. 

- Mục List: cho phép hiển thị biểu tượng theo danh sách. 

- Mục Details: cho phép hiển thị biểu tượng với đầy đủ thông tin: tên, kích thước,..  

 
Mục này cho phép sắp xếp nội dung trong cửa sổ theo tên, kích cỡ, theo ngày chỉnh sửa,... 
bằng cách nhấn chuột trên các nút. Khi đó xuất hiện dấu tam giác chỉ hướng lên xác định 
việc sắp xếp danh sách theo kiểu dưới lớn-trên nhỏ.  

- Mục Thumbnails: cho phép hiển thị các tệp ảnh. 

 

 

 

nhấn  chuột vào nút 
để thực hiện  việc  
sắp xếp 

nhấn  chuột vào  
đường biên để mở 
đầy đủ nội dung 
cần hiển thị 
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TThhaannhh  ccôônngg  ccụụ  đđịịaa  cchhỉỉ  --  AAddddrreessss  

Trên thanh công cụ Address, bấm chọn mũi tên  làm xuất hiện danh sách biểu tượng để 
chọn lựa và mở các cửa sổ khác như: Desktop, My Documents, My Computer,...  

 
Thực hành: 

(1) Nhấn chọn trên danh sách biểu tượng để mở cửa sổ Desktop. Hãy nhận xét về các đối 
tượng đang có trên màn hình nền và có trong cửa sổ Desktop. 

(2) Nhấn chọn tiếp trên danh sách biểu tượng để mở cửa sổ My Documents, Recycle Bin và 
Control Panel. 
  
Sử dụng thực đơn lệnh của cửa sổ 
Trên màn hình nền, thao tác cơ bản đó là nhấn chuột phải lên biểu tượng hay màn hình nền 
để làm xuất hiện hộp lệnh và tiếp theo là nhấn chuột trên mục lệnh được chọn. 

Trong các cửa sổ, thao tác đó vẫn đem lại kết quả như đã làm trên màn hình nền. Chúng ta 
có thể khẳng định điều đó qua bài thực hành sau đây. 
TThhaaoo  ttáácc  vvớớii  ccửửaa  ssổổ  tthhưư  mmụụcc  

(1) Mở cửa sổ My Computer. Mở ổ đĩa C. 

(2) Nhấn chuột phải lên nền cửa sổ, chọn lệnh để tạo thư mục mới đặt tên là congvan2004.  

(3) Nhấn chuột phải lên nền cửa sổ, chọn lệnh để tạo hai tệp tin có tên là CV1.txt và CV2.txt.  

(4) Chọn tệp tin CV2.txt, nhấn chuột phải và chọn lệnh Copy và Paste để sao chép tệp này 
thành hai tệp tin có tên là CV3.txt và CV4.txt 

(5) Chọn tệp tin CV3.txt và CV4.txt, nhấn chuột phải và chọn lệnh Cut và Paste để di chuyển 
hai tệp tin vào trong thư mục congvan2004. 

(6) Đặt thuộc tính chỉ đọc cho hai tệp CV3.txt và CV4.txt qua hộp lệnh. 

(7) Hiển thị thông tin của congvan2004 qua việc chọn mục Properties trong hộp lệnh. 

Kết quả như hình minh họa 
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TThhựựcc  đđơơnn  llệệnnhh  FFiillee  vvàà  EEddiitt    

Thực đơn lệnh File và Edit chứa tất cả các lệnh điều khiển tệp tin và thư mục.   

 

 

 

 

Hộp lệnh File 

(1) lệnh Open : Mở tệp tin và thư mục bất kỳ. 

(2) lệnh Send to:  

- 3 1/2 Floppy (A) : sao chép tệp tin hoặc thư mục lên đĩa mềm A. 

- Desktop (Create shortcut) : tạo một nút bấm nhanh lên màn hình nền. 

(3) lệnh New 

- Folder: tạo một thư mục mới. 

- Shortcut: tạo một nút bấm nhanh cho đối tượng tùy ý. 

- các mục: Bitmap Image, Microsoft Word Document,... cho phép tạo tệp tin rỗng. 

(4) lệnh Creat  Shortcut: Tạo nút bấm nhanh cho tệp tin hay thư mục đang được chọn. 

(5) lệnh Delete: Xóa đối tượng (tệp tin, thư mục hay nút bấm nhanh) đang được chọn 

(6) lệnh Rename: Đổi tên cho đối tượng (tệp tin, thư mục hay nút bấm nhanh) đang được 
chọn.  

(7) lệnh Properties: Hiển thị hộp thoại thuộc tính của đối tượng đang được chọn để có thể 
biết thông tin về dung lượng nhớ, số tệp tin trong thư mục, đặt thuộc tính chỉ đọc,...  

Hộp lệnh Edit thao tác với đối tượng (tệp tin, thư mục hoặc nút bấm nhanh) 

(1) lệnh Undo (hoặc sử dụng tổ hợp phím Ctrl-Z): Hồi phục trạng thái cũ. 

(2) lệnh Cut và Paste: Di chuyển đối tượng từ thư mục này đến thư mục khác 

(3) lệnh Copy và Paste: sao chép đối tượng. Có thể để đối tượng được sao chép trong cùng 
thư mục hoặc sao chép đến thư mục khác. 

(4) lệnh Paste Shortcut: tương đương như lệnh tạo Shortcut, chỉ khác về số lần nhân bản. 

(5) lệnh Copy to Folder: sao chép đối tượng nhưng có hỗ trợ hộp thoại cho phép chọn ngay 
vị trí đặt đối tượng sao chép. 
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(6) lệnh Move to Folder: di chuyển đối tượng nhưng có hỗ trợ hộp thoại cho phép chọn ngay 
vị trí đối tượng sao chép. 

(7) thực hiện chọn tệp tin và thư mục (chọn liên tục -dùng phím Shift hỗ trợ - hay chọn rời 
rạc-dùng phím Ctrl hỗ trợ) và sau đó sử dụng các lệnh (copy, cut, paste, copy to folder, move 
to folder) để sao chép và di chuyển. 

(8) lệnh Select All: chọn toàn bộ các đối tượng đang có trên cửa sổ. 

(9) lệnh Invert Selection: đảo ngược trạng thái chọn đối tượng đang có trên cửa sổ. 
  
TThhựựcc  đđơơnn  llệệnnhh  VViieeww  vvàà  TToooollss    

 

 

 

 



 

W-40 

Hộp lệnh View  

được chia làm năm nhóm nhỏ phân cách bằng đường kẻ ngang 

- lệnh Toolbars: cho phép hiển thị/che dấu thanh công cụ trên cửa sổ 

 
Dấu  xuất hiện bên trái các dòng chữ thông báo có hai thanh công cụ đang hiển thị trên cửa 
sổ đó là : thanh công cụ cơ bản (standard buttons) và thanh địa chỉ (address bar). 

Các thanh công cụ khác như thanh liên kết (Link) đang ở trạng thái che dấu vì không có dấu 
 xuất hiện bên trái.  

Để làm hiển thị hay che dấu các thanh công cụ, cách đơn giản là vào mục lệnh Toolbars và 
nhấn chuột lên phần tên của thanh. 

- lệnh Status Bar: cho phép hiển thị/che dấu thanh trạng thái của cửa sổ. 

- lệnh Explore Bar: cho phép mở các chức năng tiện ích như Search, Favorites, History, 
Folders. Việc chọn chức năng Search và Folders có thể thực hiện nhanh bằng nút bấm trên 
thanh công cụ cơ bản. 

 
- Nhóm lệnh gồm: Large Icons, Small Icons... có chức năng làm thay đổi cách hiển thị các 
biểu tượng đã được trình bày với nội dung sử dụng thanh công cụ cơ bản.  

 
 

- Nhóm lệnh Arrange Icons  

 
cho phép sắp xếp các đối tượng trong cửa sổ theo các mục: 

* By Name: sắp theo tên. 

* By Type: sắp theo kiểu hay là phần mở rộng của tên tệp. 

* By Size: sắp theo dung lượng nhớ. 

* By Date: sắp theo ngày tháng khởi tạo/chỉnh sửa đối tượng thành 
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Các mục lệnh sắp xếp By Name, By Type, By Size, By Date được áp dụng cho mọi kiểu 
hiển thị biểu tượng.  

Riêng mục lệnh Auto Arrange (nghĩa là tự động sắp xếp) chỉ được áp dụng cho kiểu hiển thị 
đối tượng dạng Large Icons, Small Icons, Thumbnails. 

Thực hành 
(1) Thay đổi kiểu hiển thị biểu tượng dạng danh sách (list). Sau đó áp dụng tính chất sắp xếp 
theo tên, theo kiểu, theo dung lượng nhớ.  

(2) Thay đổi kiểu hiển thị biểu tượng dạng khác như Large Icons, Small Icons, Detail. Sau 
đó áp dụng tính chất sắp xếp theo tên, theo kiểu, theo dung lượng nhớ.  

 

Hộp lệnh Tools  

 
Nhấn chọn mục lệnh Folder Options... làm xuất hiện hộp thoại Folder Options với năm thẻ 
cho phép thiết lập các điều khiển cho cửa sổ. 

Thẻ General 

 
- Mục Active Desktop 

 
* Chọn một trong hai lựa chọn, thông thường là chọn mục Use Windows classic desktop, 
nghĩa là chọn hình dạng màn hình nền thông thường. 
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- Mục Web View 

 

dạng cửa sổ được thể hiện thông 
thường khi chọn  

'Use Windows classic folders' 

dạng cửa sổ được thể hiện như 
trang Web khi chọn  

'Enable Web content in folders' 

 

- Mục Active Desktop 

 

* Chọn mục Open each folder in the same window thì việc mở thư mục con và thư 
mục mẹ đều nằm trong cùng một cửa sổ. Mỗi lần thao tác chỉ thấy nội dung của một thư 
mục. 

* Chọn mục Open each folder in its own window thì mỗi lần mở thư mục sẽ tạo ra 
một cửa sổ mới chứa thư mục. Như thế sẽ có nhiều cửa sổ thư mục xuất hiện.  
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- Mục Click items 

 

* Chọn mục Single-click to open ... thì việc thao tác phím chuột sẽ có thay đổi như sau: 
nhấn chuột một lần lên biểu tượng thư mục có ý nghĩa là mở thư mục, di chuyển con trỏ 
chuột lên thư mục tức là chọn thư mục. Hình dạng của biểu tượng có sự thay đổi đặc 
trưng đó là tên của các biểu tượng được gạch chân. 

 

* Chọn mục Double-click to open ... thì thao tác phím chuột như qui ước bình thường. 

* Nhấn nút Restore Defaults để có được lựa chọn tốt nhất mà hệ điều hành đã đặt sẵn. 

Sau khi chọn xong các mục phải nhấn nút OK hay nút Apply để các tính chất mới được áp 
dụng cho cửa sổ. Nhấn nút Cancel khi muốn giữ nguyên những tính chất đã có của cửa sổ, 
hủy bỏ các lựa chọn. 
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Thẻ View của hộp thoại Folder Option 

 
- Mục Display the full path in the address bar:  cho phép thay đổi cách thể hiển đường 
dẫn thư mục trên thanh địa chỉ của cửa sổ 

hình minh họa khi mục trên không được chọn  khi mục trên được chọn  

 

 
đường dẫn thư mục không được hiển thị đường dẫn thư mục C:\congvan2004 

được hiển thị 

- Mục Do not show hidden files and folders:  khi mục này được chọn, trên cửa sổ các tệp 
tin và thư mục đã đặt thuộc tính ẩn (hidden) sẽ bị che dấu đi, người sử dụng không còn nhìn 
thấy chúng. 

- Mục Show hidden files and folders:  khi mục này được chọn, các tệp tin và thư mục đã 
đặt thuộc tính ẩn (hidden) được hiển thị trở lại.  

- Mục Hide file extensions ...: khi mục này được chọn, các tệp tin bị che dấu phần mở rộng. 
Người sử dụng không nhìn thấy phần mở rộng và không sửa được chúng. 

- Mục Hide protected operating system file: khi mục này được chọn, các tệp tin cần thiết 
cho hệ điều hành được che dấu tránh việc bị xóa nhầm. Đây là mục cần được chọn. 
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- Mục Show My Document on Desktop: khi mục này được chọn, biểu tượng My 
Documents xuất hiện trên màn hình nền. Xóa bỏ chọn trên mục này sẽ làm mất biểu tượng 
My Documents trên màn hình nền. 

- Nút Restore Default: Đặt các mục về lại giá trị đầu tiên được hệ điều hành qui định.  

 
TThhựựcc  đđơơnn  llệệnnhh  HHeellpp  

 
Lưu ý: Có thể mở cửa sổ tra cứu bằng cách nhấn nút Start -> Help 

Tra cứu theo thẻ Contents: 

Trong thẻ Contents các nội dung được trình bày theo trình tự nhóm nội dung. Nhấn chọn tiêu 
đề ở khung bên trái sẽ làm xuất hiện nội dung chi tiết ở khung bên phải. 

Tra cứu theo thẻ Index: 

 
Gõ từ khóa vào ô tìm kiếm sẽ làm xuất hiện các tiêu đề liên kết trong khung bên trái. Sau đó 
nhấn chọn tiêu đề cần tìm để làm xuất hiện nội dung chỉ dẫn ở khung bên phải. 

Tra cứu theo thẻ Search: 

 
Gõ từ khóa vào ô tìm kiếm sẽ làm xuất hiện các mục nội dung có chứa từ khóa tra cứu. Nhấn 
chọn đầu mục nội dung trong khung bên trái sẽ làm xuất hiện nội dung chỉ dẫn ở khung bên 
phải. Tất cả chỉ dẫn đều bằng tiếng Anh, đó là một khó khăn cho những người không thành 
thạo tiếng Anh.  
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Chương trình tiện ích Microsoft Explorer 

Với chương trình này chúng ta có thể thao tác với mọi đối tượng mà hệ điều hành sử dụng để 
quản lý thư mục một cách trực quan, đầy đủ và chính xác. Đây là một tiện ích không thể bỏ 
qua được. 
MMởở  ttiiệệnn  íícchh  vvềề  tthhưư  mmụụcc  --  FFoollddeerrss  

Cách 1: Bấm nút Folder trên thanh công cụ cơ bản 

Cách 2: chọn thực đơn View -> Explorer Bar -> Search 

Cách 3: nhấn chọn nút Start -> Programs -> Accessories -> Windows Explorer. 

 
- Khi mở tiện ích Folder, chúng ta thấy xuất hiện thêm một vùng nội dung mới gọi là vùng 
bên trái và vùng nội dung trước đây đã có gọi là vùng bên phải. 

- Vùng bên trái hiển thị các đối tượng mà hệ thống sử dụng để quản lý về thư mục. Vùng bên 
phải hiển thị nội dung của mỗi đối tượng được chọn ở vùng bên trái. 

- Trên các vùng có các thanh cuốn ngang, cuốn dọc cho phép xem hết nội dung của vùng. 

- Như vậy chỉ có vùng bên trái là vùng chúng ta cần tìm hiểu và thao tác. 
ĐĐóónngg  ttiiệệnn  íícchh  vvềề  tthhưư  mmụụcc    

Để đóng tiện ích này, chúng ta nhấn chuột lên nút Folder trên thanh công cụ cơ bản hoặc 
nhấn vào nút x trên thanh Folder của vùng bên trái. 

TThhaaoo  ttáácc  vvớớii  vvùùnngg  bbêênn  ttrrááii  

(1) Các khái niệm cơ bản 

Trong khung nhìn bên trái có xuất hiện dấu (+), dấu (-) và các đường kẻ. Chúng ta xem xét 
vùng bên trái theo hình minh họa sau 

vùng bên 
phải 

vùng bên 
trái 
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- Đường kẻ dọc cho biết cấp của thư  mục: ví dụ thư mục sat-hach-mon2, sat-hach-mon3 là 
cùng cấp và thư mục mẹ của chúng là QL_sathach2004. 

- Dấu (-) đứng trước thư mục QL_sathach2004 cho biết thư mục này đang mở. Nhấn vào 
dấu trừ (hoặc nhấn đúp vào biểu tượng thư mục) sẽ làm xuất hiện dấu (+). 

- Vậy dấu (+) đứng trước đối tượng nào đó là để báo hiệu đối tượng đó có chứa các thư mục 
con nhưng hiện đang ở trạng thái thu gọn. Nhấn chuột vào dấu (+) (hoặc nhấn đúp vào biểu 
tượng thư mục) sẽ mở rộng cây thư mục làm xuất hiện các thư mục con. Khi đó dấu (-) xuất 
hiện thay cho dấu (+). 

- Một số thư mục không có dấu (+) hay dấu (-) đặt trước biểu tượng. 

Ví dụ thư mục sat-hach-mon2. Điều đó có nghĩa là thư mục này không có chứa thư mục con 
nào cả. Thư mục sat-hach-mon2 chỉ chứa toàn là tệp tin. Nếu chúng ta tạo thư mục con mới 
thì tức khắc dấu (+) sẽ xuất hiện phía đầu biểu tượng thư mục. 

(2) Thao tác mở thư mục trong vùng bên trái 

Nhấn chuột vào thư mục. 

(3) Thao tác tạo thư mục con mới 

Bước 1: Nhấn chuột chọn thư mục mẹ ở vùng bên trái. 

Bước 2: Nhấn chuột vào thực đơn File-> New-> Folder.   

(4) Đổi tên thư mục  

Nhấn chuột lên phần tên và sau đó gõ tên mới hoặc 

Nhấn chọn thư mục, sau đó nhấn chuột vào thực đơn File-> Rename 

(5) Các thao tác khác như: sao chép/di chuyển/xóa/xem thuộc tính... 

Trước tiên là thao tác chọn thư mục trong vùng bên trái. 

Tiếp theo là nhấn chuột vào thực đơn File và Edit để chọn lệnh có mặt trong hai hộp lệnh 
này theo cách mà chúng ta đã làm với vùng nội dung của một cửa sổ. 
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Tìm kiếm thông tin 

Sau một thời gian tạo ra nhiều thư mục và tệp tin, chúng ta sẽ nhận ra được ba điều: 

(1) cần đầu tư thời gian và suy nghĩ cho việc tổ chức các thư mục. Nếu các thư mục được tổ 
chức tốt trên ổ đĩa cứng thì việc tìm kiếm các tệp tin mới được nhanh chóng và chính xác.   

(2) cần có một qui tắc cho việc đặt tên tệp tin. Ví dụ đặt tên tệp là congvan-08072004-1 sẽ 
cho chúng ta nhiều thông tin hơn tên tệp congvan-1. 

(3) có những yêu cầu về tìm kiếm thư mục cần phải được hỗ trợ bằng chương trình tiện ích 
như:  

- liệt kê tất cả các tệp tin trên ổ đĩa C có chứa từ congvan trong phần tên. 

- liệt kê tất cả các tệp tin trên ổ đĩa C vừa mới tạo trong khoảng thời gian là một tháng so với 
ngày hiện tại. 
MMởở  cchhưươơnngg  ttrrììnnhh  ttììmm  kkiiếếmm    

Cách 1: Trên cửa sổ thư mục đang mở, nhấn chọn nút Search hoặc chọn thực đơn lệnh 
View-> Explore Bar -> Search. 

Cách 2:  Đang ở màn hình nền, nhấn chọn nút Start -> Search -> For Files or Folders 

 
Vùng làm việc của cửa sổ tìm kiếm được chia thành hai phần: vùng bên trái và vùng bên 
phải. 

vùng bên 
phải vùng bên trái 
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ĐĐóónngg  cchhưươơnngg  ttrrììnnhh  ttììmm  kkiiếếmm    

Nhấn nút Search trên cửa sổ thư mục hay nhấn nút x trên thanh Search của vùng bên trái. 
TThhaaoo  ttáácc  vvớớii  vvùùnngg  bbêênn  ttrrááii  

(1) Các ô để nhập cụm từ tìm kiếm: 

- Ô nhập Search for files or folders named: 

đây là nơi nhập cụm từ sẽ được tìm kiếm trong phần tên của tệp tin và thư mục. 

Theo hình minh họa, gõ từ khóa congvan sẽ làm xuất hiện kết quả là 01 tệp tin và 02 thư 
mục có phần tên bắt đầu là congvan. 

Ngoài việc liệt kê tất cả các tệp tin thỏa mãn yêu cầu, chúng ta còn thấy được con số trên 
thanh trạng thái cho biểt tổng số thư mục và tệp tin kết quả. Nếu con số kết quả là 0 có nghĩa 
là không có thư mục và tệp tin nào thỏa mãn yêu cầu tìm kiếm. 

- Ô nhập Containing text: 

đây là nơi nhập cụm từ sẽ được tìm kiếm trong phần nội dung của tệp tin. Ví dụ gõ cụm từ 
"bảng lương" trong ô Containing text. Nhấn nút Search Now và chương trình tìm kiếm sẽ đi 
tìm những tệp tin có phần nội dung chứa từ này. Kết quả (nếu có) là danh sách tên của tệp tin 
được hiển thị trong khung cửa sổ bên phải. 

(2) Ô chọn nơi tìm kiếm - Look in 

 
Trong ô chọn Look in, nhấn chuột ở mũi tên bên phải để làm xuất hiện danh sách các ổ đĩa. 
Sau đó di chuyển con trỏ chuột về ổ đĩa muốn tìm kiếm và nhấn chuột để xác định. Ngoài ra 
còn có thể nhấn chọn mục Browse... để đi xác định một thư mục tìm kiếm cụ thể hơn.  

 
Việc xác định nơi tìm kiếm càng cụ thể thì phạm vi tìm kiếm thu hẹp lại và làm giảm bớt 
thời gian tìm kiếm. 
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(3) Nút thao tác 

Nhấn nút Search sau khi đã chuẩn bị xong các điều kiện tìm kiếm. 

Nhấn nút Stop để ngừng quá trình tìm kiếm nếu đã thấy được tệp tin hay thư mục cần tìm 
xuất hiện ở vùng bên phải hoặc muốn tạo lại yêu cầu tìm kiếm. 

(4) Mục Search Options - nơi cho phép lập ra các điều kiện mở rộng  

 
TThhaaoo  ttáácc  vvớớii  vvùùnngg  bbêênn  pphhảảii    

Vùng bên phải có thể xem như là vùng làm việc của cửa sổ thư mục mà chúng ta đã làm 
việc. Như vậy việc thao tác với các tệp tin và thư mục trên vùng này không có gì phải bàn 
thêm. 

 
Nhưng có một điểm khác biệt cơ bản đó là chúng ta không tạo thêm được tệp tin và thư mục 
trong vùng này. Đối tượng mà chúng ta có thể thao tác là các tệp tin, thư mục, nút bấm 
nhanh (Shortcut) được tìm thấy theo điều kiện.  

Chúng ta nên hiển thị vùng bên phải theo dạng chi tiết để dễ dàng sắp xếp và xử lý. 

 
Việc tìm kiếm của chương trình không thực hiện trên các đối tượng đang chứa trong thùng 
rác - Recycle Bin. Nghĩa là không có thao tác tìm kiếm trên những đối tượng đã bị xóa đang 
nằm trong thùng rác. 

 

nội dung 
được trình 
bày chi tiết 

có thể thao tác sắp 
xếp, chọn đối tượng, 
sao chép, di chuyển, 
xóa, đổi tên, xem 
thuộc tính
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TTạạoo  ccụụmm  ttừừ  ttììmm  kkiiếếmm  

Trong ô nhập Search for files or folders named  (dịch sang tiếng Việt là tìm theo tên tệp và 
thư mục), cụm từ tìm kiếm có thể nhập vào là:  

* một phần đầu của tên, ví dụ  như là congvan 

Kết quả tìm kiếm có thể là những tệp tin có phần đầu của tên trùng với từ tìm kiếm gồm:  
congvan2004, congvan.txt, congvankhan,... 

* một phần của tên kết hợp với ký tự *. Ký tự * cho phép thay thế một dãy kí tự có nội dung 
và độ dài bất kỳ.  

Ví dụ như cụm từ tìm kiếm là *.txt 

Kết quả tìm kiếm có thể là tên các tệp tin như: congvan.txt, baocao.txt...  

Nhận xét: các tên tìm được có phần tên tự đặt là bất kỳ nhưng phần mở rộng phải là 
'.txt'. 

 
- Ví dụ như cụm từ tìm kiếm là *doc 

Kết quả tìm kiếm có thể là các tên: doc, javadoc.exe, Ora-PHP Connectivity.doc...  

Nhận xét: các tên tìm được có phần tên tự đặt chứa cụm từ 'doc' ở cuối hoặc có phần 
mở rộng là '.doc'. 

 
- Ví dụ như cụm từ tìm kiếm là *doc* 

Kết quả tìm kiếm có thể là các tên có chứa cụm từ 'doc' ở vị trí bất kỳ như: My 
Documents, javadoc.exe, LDoc-PHP.doc...  

* Ngoài ra một phần của tên kết hợp với ký tự ?. Ký tự ? thay thế cho một kí tự. 

- Ví dụ như cụm từ tìm kiếm là co??v?n 

Kết quả tìm kiếm có thể là các tên bắt buộc phải có ký tự bất kỳ tại vị dấu ?. Các tên 
đúng theo điều kiện là: congvan.txt, congvan, cow-vin.txt,...  
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TTììmm  kkiiếếmm  mmởở  rrộộnngg  tthheeoo  nnggààyy  tthháánngg,,  kkiiểểuu  ttệệpp,,  dduunngg  llưượợnngg  nnhhớớ    

 
Mục Date - ngày tháng 

Khi chúng ta muốn tìm kiếm theo ngày tháng thì nhấn chọn mục Date làm mở rộng hộp 
thoại. 

 
* phần chọn thứ nhất là một trong các mục: 

files Modified - để tìm theo ngày sửa đổi tệp 
tin và thư mục.   

files Created  - để tìm theo ngày tạo lập của 
thư mục và tệp tin  

files  Last Accessed - để tìm theo ngày gần 
nhất đã thao tác mở thư mục và tệp tin. 

 

* phần chọn thứ hai là một trong các mục sau: 

 - mục này hạn chế việc tìm kiếm tệp tin và thư 
mục theo số tháng gần với tháng hiện tại. Hệ điều 
hành lấy đồng hồ hệ thống làm mốc thời gian nên 
phải chỉnh đồng hồ cho đúng. Chúng ta có thể 
tăng giảm số tháng trong ô.  

 
- mục này hạn chế việc tìm kiếm tệp tin và thư 
mục theo số ngày gần với ngày hiện tại  

 

- mục này hạn chế việc tìm kiếm tệp tin và thư 
mục theo khỏang thời gian giữa hai ngày được xác 
định cụ thể trong hai ô. 
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Mục Type - kiểu tệp  

Khi muốn hạn chế tập tin tìm kiếm chỉ theo một kiểu nhất định thì nhấn chọn mục Type, sau 
đó nhấn chọn vào mũi tên tam giác làm xuất hiện danh sách chọn. Di chuyển con trỏ chuột 
và nhấn chọn một kiểu tệp theo danh sách biểu tượng được nhìn thấy. 

Lưu ý: Có cách khác tương đương khi biết chính xác phần mở rộng của tệp tin.Ví dụ cho 
kiểu tệp .doc là gõ câu điều kiện trong ô nhập tên với kiểu nhập là *.doc 

 
Mục Size - dung lượng nhớ 

Khi muốn hạn chế tập tin tìm kiếm chỉ theo dung lượng nhớ thì nhấn chọn mục Size, sau đó 
nhấn chọn vào mũi tên tam giác làm xuất hiện lựa chọn.  

*  at least - có nghĩa là tối thiểu 

* at most - có nghĩa là tối đa. 

Nếu chúng ta muốn tệp tin tìm kiếm là những tệp có dung lượng lớn hơn 50KB thì chọn nội 
dung 'at least' và đánh con số 50 vào ô số KB. 

 
 

Mục Advanced Option - điều kiện mở rộng 
Khi muốn hạn chế việc tìm kiếm chỉ trên một thư mục (ví dụ như ổ đĩa C) thì nhấn chọn mục 
điều kiện mở rộng và xóa chọn của ô Search Subfolder. 
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TTổổnngg  hhợợpp  đđiiềềuu  kkiiệệnn  ttììmm  kkiiếếmm  

Các tệp tin và thư mục được tìm thấy phải thỏa mãn tất cả các điều kiện đã được lựa chọn. 

 
Theo hình minh họa trên, hệ điều hành tìm kiếm các tệp tin như sau: 

+ tìm trên ổ đĩa C 

+ các tệp tin có chữ cái đầu tiên là w 

+ mới được trong khoảng thời gian là 1 tháng 

+ kiểu tệp là DOC 

+ tệp tin có dung lượng nhớ thỏa mãn lớn hơn 50KB 

+ chỉ tìm kiếm tệp tin trong ổ đĩa C, không làm tiếp trong các thư mục con của ổ đĩa C. 

TTììmm  kkiiếếmm  ccáácc  đđốốii  ttưượợnngg  kkhháácc  

Ngoài chức năng tìm kiếm thư mục và tệp tin, Windows còn cho phép tìm kiếm các đối 
tượng khác như địa chỉ của máy tính trong mạng, thông tin cá nhân đã đăng ký,… 

Mục Computers: cho phép gõ địa chỉ máy tính trên mạng để tìm kiếm. 

Mục People: cho phép tìm thông tin cá nhân theo sổ danh bạ địa chỉ của máy.  
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Cửa sổ Control Panel 
Từ trong cửa sổ My Computer chúng ta có thể nhấn đúp lên biểu tượng Control Panel  

hoặc  nhấn chuột lên nút Start -> Settings -> Control Panel.  

 

 
Làm việc với các thông số của hệ thống 
Trong cửa sổ Control Panel, nhấn đúp vào biểu tượng System để hiển thị hộp thoại System 
Properties. 
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Xem/chỉnh sửa thời gian của hệ thống 

Trong cửa sổ Control Panel nhấn đúp chuột vào biểu tượng Date/Time để mở cửa sổ Date 
and Time Properties  

 
 Thao tác nhanh:  

Bấm đúp chuột lên ngày giờ hệ thống xuất hiện ở góc dưới bên phải 
của Thanh tác vụ.  

 

Gỡ bỏ/ cài đặt thêm các chương trình 

Nhấn đúp chuột lên biểu tượng    trong cửa sổ Control Panel đế mở hộp thoại 
Add/Remove Programs 

 

 
* Chọn lựa một chương trình đã cài đặt, ví dụ chọn Bach Khoa Antivirus 2002 như hình 
minh họa, sau đó nhấn nút Change/Remove để gỡ bỏ chương trình khỏi hệ điều hành. 

* Muốn cài thêm/gỡ bỏ một thành phần cho thanh thực đơn Start, chúng ta bấm chọn nút 
Add/Remove Windows Components. Ví dụ sau khi cài đặt chúng ta muốn cài thêm các 
chương trình trò chơi (Game) sẵn có trong bộ chương trình cài đặt của hệ điều hành.  

Thay đổi âm thanh hệ thống 
Muốn thực hiện được các thao tác thay đổi âm thanh, máy tính phải có thiết bị phần cứng về 
âm thanh gồm Sound Card (thẻ âm thanh) gắn trên bảng mạch chính.  
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Nhấn đúp vào biểu tượng loa   ở góc dưới bên phải màn hình nền để mở hộp thoại 
Volume Control.  

 
 
Thay đổi điều khiển bàn phím  

Nhấn đúp chuột lên biểu tượng   trong cửa sổ Control Panel đế mở hộp thoại 
Keyboard Properties. Hộp thoại này cho phép thêm các mẫu bàn phím theo các ngôn ngữ 
khác nhau, ví dụ có thể mẫu bàn phím tiếng Việt, sau đó chúng ta có thể gõ tiếng Việt mà 
không cần phải sử dụng thêm chương trình hỗ trợ gõ tiếng Việt.  

 
Khi có nhiều mẫu bàn phím thì việc chuyển đổi mẫu bàn phím có thể được thực hiện như 
sau: 

hoặc mở hộp thoại Keyboard Properties 

hoặc nhấn đúp chuột lên biểu tượng chữ EN nằm ở góc dưới bên phải màn hình nền làm 
xuất hiện hộp danh sách và nhấn chuột lên mẫu bàn phím muốn chọn. 
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Thay đổi điều khiển chuột máy tính  

Nhấn đúp chuột lên biểu tượng  trong cửa sổ Control Panel đế mở hộp thoại Mouse 
Properties.  

Thẻ Buttons 

 
* Phần Button configuration 

Nếu chọn Left-handed thay thế Right-handed thì chức năng của hai nút chuột bị đảo cho 
nhau. 

* Phần Files and Folders  

Nếu chọn Single-click ... thay cho Double-click... thì việc di con trỏ chuột trên biểu tượng 
cũng chính là chọn biểu tượng. Biểu hiện cho việc chọn Single-click là trong các cửa sổ 
chúng ta thấy tên biểu tượng có dấu gạch chân.  

* Phần Double-click speed 

Có thể điều chỉnh độ trễ cho việc nhấn đúp bằng cách di chuyển núm trên thanh trượt  về trái 
hoặc phải. Đặt tại vị trí ở giữa là tốt nhất. 
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Thẻ Pointer 

 
* Phần Scheme 

Nhấn nút tam giác làm xuất hiện danh sách chọn mẫu.  
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Mỗi mẫu chọn gồm nhiều hình ảnh khác nhau của con trỏ chuột theo từng  tình huống của hệ 
thống. Ví dụ chọn mẫu Conductor thì hình ảnh con trỏ chuột thay đổi 

* hình ảnh bàn tay chỉ lên thay cho mũi tên màu trắng như chúng ta thường sử dụng 

 
Để đặt hình ản về dạng thường sử dụng, chúng ta nhấn nút Use Default cho từng nội dung 
trong mục Customize hoặc chọn giá trị None trong mục Sheme. 

Nhấn nút Apply để thực hiện những lựa chọn nhưng chưa đóng hộp thoại 

Nhấn nút OK để đồng ý với những lựa chọn đồng thời đóng hộp thoại.  

Nhấn nút Cancel để bỏ qua các lựa chọn và đóng hộp thoại. 

Làm việc với Display Properties  

Trong cửa sổ Control Panel, bấm đúp biểu tượng Display để mở hộp thoại Display 
Properties. 

Màn hình chính của hệ điều hành Windows cũng như màn hình chính trong các hệ điều hành 
trước đó (như Windows 95, Windows 98) được gọi tên là DESKTOP. Có thể hình dung màn 
hình chính như mặt bàn làm việc của mọi người. Tất cả những gì cần phải làm hay đang làm 
dang dở  mọi người thường đặt trên màn hình chính. Nếu nhiều người dùng chung một máy 
tính thì Windows cho phép mỗi người có một màn hình chính riêng biệt, đó chính là tính cá 
nhân hoá môi trường làm việc được hệ điều hành Windows hỗ trợ. 
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TThhẻẻ  BBaacckkggrroouunndd  

Cho phép thay đổi ảnh, mẫu nền của màn hình nền. 

 
Thao tác: 

 Chọn thẻ Background trong hộp thoại Display Properties. 

 Lựa chọn một ảnh tuỳ ý trong danh sách chọn, ví dụ chọn Gold Petals.  

 Chọn cách hiển thị ảnh nền trong ô Picture Display.  

o Chọn mục Center - ảnh được hiển thị ở giữa màn hình 

o Chọn mục Tile - ảnh được sao chép để lấp kín nền 

o Chọn mục Stretch - ảnh được phóng to để lấp kín nền. Tùy theo cỡ lớn 
của ảnh để chọn mục thích hợp. 

 Nút Pattern cho phép chỉnh sửa  mẫu dạng của màn hình nền.  
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TThhẻẻ  bbảảoo  vvệệ  mmàànn  hhììnnhh  --SSccrreeeennSSaavveerr  

cho phép thiết lập các kiểu bảo vệ màn hình, tiết kiệm điện năng cho máy tính trong những 
thời gian máy đang bật nguồn điện nhưng chưa sử dụng.  

 
Thao tác: 

 Chọn thẻ ScreenSaver  

 Nhấn Settings để thay đổi các hiệu ứng về màu sắc, tần số xuất hiện hình 
ảnh, ... 

 Nhấn Preview để xem các thay đổi vừa thực hiện. 

 Chỉnh số phút chờ tín hiệu từ thiết bị nhập ở ô Wait. Sau số phút qui 
định, hệ thống tự động chuyển màn hình sang chế độ bảo vệ.  

 Thiết lập chế độ tiết kiệm điện năng cho màn hình, ổ đĩa cứng và cả hệ 
thống bằng cách nhấn nút Power và sau đó điều chỉnh khỏang thời gian 
ngừng cung cấp nguồn điện cho các thiết bị màn hình, ổ cứng. 
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Thẻ Appearance -Thiết lập cửa sổ hệ thống theo mẫu sẵn có 

 

Thao tác: 

 Chọn mẫu cửa sổ trong mục Scheme. Mẫu thường dùng là Windows 
Standard. 

 Chọn từng chi tiết của cửa sổ để chỉnh sửa trong mục Item. Có thể chỉnh 
chi tiết màu của thực đơn lệnh-Menu, ... Mỗi lần chỉnh sửa, hình ảnh 
minh hoạ về cửa sổ có thay đổi tương ứng giúp cho người dùng có thể ra 
quyết định cuối cùng.  

 Nhấn nút Apply để áp dụng mẫu cửa sổ mới cho hệ thống nhưng chưa 
đóng cửa sổ Display Properties. 

 Nhấn nút OK để áp dụng mẫu đã chọn và đóng luôn cửa sổ Display 
Properties. 
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 Thẻ Effects- thiết lập hiệu ứng trên cửa sổ 

 
Thẻ Settings-Thiết lập độ phân giải màn hình 
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Sử dụng thùng rác - Recycle Bin  
Khi tiến hành xoá bất kỳ thư mục / tệp tin nào trong máy tính, thư mục/tệp tin đó sẽ được 
chuyển tới Recycle Bin (hay còn gọi là thùng rác).  Có thể khôi phục lại các đối tượng bị 
xoá từ Recycle Bin.  

  Biểu tượng của thùng rác có chứa đối tượng đã bị xóa bên trong. 

Trên màn hình nền nhấn đúp chuột trên biểu tượng thùng rác-Recycle Bin để mở cửa sổ. 

 
* Nhấn nút Empty Recycle Bin nếu muốn xóa sạch mọi đối tượng trong thùng rác. 

* Để xóa từng đối tượng thì phải thao tác chọn đối tượng và nhấn nút Delete. Khi hộp thoại 
xuất hiện thì trả lời Yes. 

 
* Nhấn nút Restore All nếu muốn hồi phục toàn bộ đối tượng có trong thùng rác.  

* Để hồi phục một đối tượng (hoặc là một nhóm đối tượng gồm thư mục/tệp tin/nút bấm 
nhanh...) đã bị xóa, chúng ta thực hiện: 

- Chọn đối tượng và nhấn chọn thực đơn File -> Restore 
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Định dạng đĩa mềm 
Hệ điều hành chỉ có thể  ghi/đọc thông tin trên đĩa đã được định dạng theo tiêu chuẩn tương 
thích với hệ điều hành. Ngày nay, hầu hết các nhà sản xuất đĩa mềm thực hiện thao tác này 
trước khi đưa ra thị trường. Trong quá trình sử dụng, khi đĩa mềm gặp lỗi định dạng thì 
người sử dụng thực hiện định dạng lại đĩa mềm để tái sử dụng.  

Thao tác định dạng đĩa mềm 

1. Mở cửa sổ My Computer 

2. Đặt đĩa mềm A vào ổ đĩa 

3. Nhấn chọn ổ đĩa A trong cửa sổ My Computer 

4. Nhấn chọn thực đơn File -> Format để mở hộp thoại Format 

5. Nhấn nút Start để hệ điều hành bắt đầu quá trình định dạng đĩa cho đến khi có 
hộp thoại thông báo quá trình thực hiện đã hoàn tất. 

6. Nhấn nút Close để đóng hộp thoại. 
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Soạn thảo đơn giản 
Bàn phím với chức năng soạn văn bản 

àn phím hiện nay là kết quả của nhiều giai đoạn thay đổi và hoàn thiện. Tuy mỗi nhà sản xuất đều có các 
công trình nghiên cứu riêng song hiện nay, họ đã đi đến thống nhất với nhau nguyên tắc chung  về số 
lượng và vị trí của các phím 

  

Hiện nay, thế giới thường sử dụng loại bàn phím 101/ 102 phím. 

Các phím thường được chia thành các nhóm sau: 

+ Nhóm các phím kí tự: dùng để nhập chữ cái và các dấu (phẩy, chấm, ngoặc kép, lớn hơn, nhở 
hơn,…) 

+ Nhóm các phím số: dùng để nhập chữ số và kí hiệu (tiền tệ $, phần trăm %,…) 

+ Nhóm các phím chức năng: từ F1 đến F12 

+ Nhóm các phím điều khiển: Tab, Delete, Page Up, Page Down, Enter,… 

+ Nhóm phím hỗ trợ: Ctrl, Alt, Shift. 

 

Phím Caps Lock  

Khi bật phím Caps lock thì đèn Caps lock (thường ở vị trí trên cùng, bên phải bàn phím) 
cùng sáng, báo hiệu chế độ nhập văn bản chữ hoa đã sẵn sàng. 

Phím Enter 
Nhấn phím Enter khi muốn thực hiện lệnh hay kết thúc một đoạn văn bản và xuống dòng 
mới. 

Phím Tab 

Chuyển đến đối tượng kế tiếp trong chương trình hoặc di chuyển qua nhiều khoảng trắng 
một lúc 

Phím Ctrl 

Phím Ctrl thường dùng kèm một phím khác để xác định một mệnh lệnh điều khiển (ví dụ: 
Ctrl + C = Copy) 

Phím Shift 
Giữ phím Shift trong khi nhập văn bản sẽ nhập các kí tự hoặc dấu được ghi ở phía trên cùng 
của mỗi phím 

Chương 

4
B 
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Phím Home 

Về đầu dòng hoặc đầu trang tài liệu siêu văn bản 

Phím End 

Về cuối dòng hoặc cuối trang tài liệu (siêu văn bản) 

Phím Page Up / Page Down 

Cuộn lên / cuộn xuống giữa các trang tài liệu 

Phím Esc 

Hủy bỏ các giao tiếp giữa người-máy. Đóng hộp thoại. 

Chương trình WordPad 
Đây là chương trình soạn thảo văn bản đi kèm với hệ điều hành Windows. 

MMởở  ccửửaa  ssổổ  ssooạạnn  tthhảảoo    
Nhấn chọn nút Start -> Programs -> Accessories -> Wordpad 

Giao diện của chương trình xuất hiện như sau: 

 
  
GGhhii  llưưuu  

Nhập một đoạn văn bản ngắn để sử dụng thành thạo các chức năng phím đã được giới thiệu. 
Sau đó để ghi lưu nội dung thành một tệp tin trên đĩa thì nhấn chuột vào biểu tượng Save 
trên thanh công cụ hoặc sử dụng lệnh Save… trong thực đơn lệnh File.  

Nếu tài liệu mới được tạo ra, cần lưu ý: 

* Đặt tên cho tài liệu: Gõ tên tài liệu (nên gõ không dấu và không có khoảng trống) vào 
hộp thoại File name 

* Chọn thư mục (nơi đặt tệp văn bản) trong hộp thoại Save in. Có thể nhấn vào các biểu 
tượng (History, My Documents, Desktop, Favorite,..) trên thanh công cụ bên trái hộp thoại Save in 
để truy cập nhanh đến các thư mục lớn trong máy tính. 

thanh tiêu 
đề thanh thực đơn lệnh 

thanh 
công cụ

vùng nội dung 
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Trong hình minh họa, thao tác các mục sau: 

(1) chọn nhanh các thư mục hay dùng như: My Documents, Desktop 

(2) tạo thư mục mới cho phép tạo thư mục mới mà không cần trở về màn hình chính 

(3) sử dụng các nút tiện ích: di chuyển tiến/lùi các thư mục, xem văn bản theo dạng rút gọn 
hay đầy đủ, sắp xếp tệp và thư mục theo tên, phần mở rộng, ngày cập nhật,... 

(4) gõ tên cho tệp văn bản trong ô File name 

(5) có thể chọn kiểu tệp sao lưu khác như Unicode Text Document bằng cách chọn trong ô 
Save as Type.  

 
(6) Để lưu tài liệu lên đĩa mềm, cần đưa đĩa mềm vào ổ A  và chọn mục  31/2Floppy (A) trong 
hộp thoại Save in 

 

chọn nhanh các 
thư mục hay dùng 
tại đây 

bấm vào đây để 
chọn các ổ đĩa hay 
các thư mục khác  

nút tiện ích 

tạo thư 
mục mới 
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Quản trị in ấn 
Cài đặt một máy in 

Cài đặt máy in là thao tác rất cần thiết cho những nội dung tiếp theo như: sử dụng chương 
trình soạn thảo văn bản, bảng tính điện tử,... 

Việc cài đặt máy in không đòi hỏi phải có máy in thực sự đang kết nối với máy tính. Chúng 
ta sẽ thao tác cài đặt một máy in nằm trong danh sách các máy in được hệ điều hành hỗ trợ, 
điều đó có nghĩa là chúng ta không cần có thêm các đĩa cài đặt từ bên ngoài.  

Bước 1: Nhấn chọn nút Start -> Settings -> Printers để mở cửa sổ Printers. 

 
Bước 2: Nhấn đúp biểu tượng Add Printer làm xuất hiện hộp thoại Add Printer Wizard.  

 
Bước 3: Nhấn nút Next để làm xuất hiện hộp thoại tiếp theo 

 
Trong hộp thoại vẫn giữ nguyên giá trị chọn tại ô Local printer, xóa bỏ chọn tại ô 
Automatically detect... 

Bước 4: Nhấn nút Next để làm xuất hiện hộp thoại tiếp theo 
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Giữ nguyên các giá trị chọn trong các mục. Nhấn nút Next, đợi 30 giây để xuất hiện hộp 
thoại tiếp theo. 

Bước 5: Trong hộp thoại mới, chúng ta chọn lựa tên công ty sản xuất là HP, tên sản phẩm 
máy in là HP LaserJet 6L. Đây là loại máy in thường dùng tại các văn phòng.  

Nếu chúng ta không tìm thấy tên máy in cần cài đặt thì  việc cài đặt sẽ bắt đầu từ đĩa 
CDROM được nhà sản xuất máy in cung cấp kèm theo máy. Các bước thao tác hoàn toàn 
khác hẳn những điều mà chúng ta đã thực hiện từ bước 1 đến bước 5 hiện nay. 

 
Các bước tiếp theo đơn giản là đồng ý với các lựa chọn sẵn có và nhấn nút Next cho đến khi 
gặp trang cuối cùng thông báo việc cài đặt máy in thành công.  

 
Nhấn nút Finish để đóng hộp thoại. 
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Chọn máy in ưu tiên 

Trong cửa sổ Printer có thể có nhiều máy in được cài đặt nhưng chỉ có một máy in ưu tiên. 

Hình ảnh của máy in ưu tiên được thế hiện là   

 
Thay đổi máy in ưu tiên 

Bước 1: trong cửa sổ Printer, nhấn chọn một biểu tượng máy in muốn đặt ưu tiên. 

Bước 2: nhấn chuột phải (hay nhấn chọn thực đơn lệnh File) làm xuất hiện hộp lệnh. Chọn 
lệnh Set as Default Printer. Máy in được chọn chuyển sang biểu tượng máy in được ưu 
tiên. 

 
In văn bản từ chương trình WordPad 
Trong cửa sổ văn bản WordPad, nhấn chọn thực đơn lệnh File-> Print  

 
hoặc bấm tổ hợp phím Ctrl + P  làm xuất hiện hộp thoại Print. 
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Thẻ General 

Phần Select Printer 

* Hiện nay máy in ưu tiên là HP Laser Jet 5N, chúng ta có thể nhấn chọn máy in khác để in 
văn bản.  

* Ô chọn Print to file: nhấn chọn ô này để tạo ra tệp đặc biệt chứa khuôn dạng in.  

Phần Page range 

Danh sách một lựa chọn gồm: 

* ô All    : chọn ô này để xác định là in tất cả các trang văn bản.  

* ô Selection  : chọn ô này để xác định là chỉ in nội dung văn bản được chọn (hay gọi nôm 
na là bôi đen). Trong hình minh họa, ô này không họat động vì không có vùng văn bản nào 
được chọn. 

* ô Current Page: chọn ô này để xác định trang in là trang hiện đang chứa con trỏ văn bản. 

* ô Pages   : chọn ô này để xác định in theo số trang tùy chọn. Ví dụ nhập vào ô con số 
1-50 để xác định in từ trang 1 đến trang 50. 

Phần Number of Copies 

* Ô chọn của mục Number of copies cho phép lựa chọn (hoặc nhập vào) số lần in của mỗi 
trang. 

Nhấn nút Print để bắt đầu in, nhấn nút Cancel để hủy bỏ các lựa chọn và đóng hộp thoại. 

Thẻ Layout 

Trong thẻ Layout chúng ta có thể đặt các lựa chọn sau: 

Phần Orientation (hướng in ra giấy)   
* Ô Portrait - chọn ô để đặt hướng in theo chiều dọc từ phía mép trên trang giấy xuống dưới. 

* Ô Landscape - chọn ô để đặt hướng in theo chiều ngang. 

Lưu ý: Chỉ nên đặt chọn ô Portrait. 
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Phần Page Order (trật tự trang in) 

* Ô Front to Back  - chọn ô để đặt trật tự trang in theo qui tắc là số trang bé nhất được in đầu 
tiên (ví dụ trang 1 được đầu tiên và trang cuối văn bản được in sau cùng). 

* Ô Back to Front  - chọn ô để đặt trật tự trang in theo qui tắc là trang có số trang lớn được in 
trước những trang có số trang bé hơn.  

 
Quản lý các văn bản sau khi ra lệnh in  
Sau khi nhấn nút Print ra lệnh in, chúng ta có thể theo dõi và điều khiển các văn bản được in 
qua cửa sổ quản lý văn bản in ấn. 

 
Theo hình minh họa trên, có ba văn bản đang chờ đợi in. Cột Status (trạng thái) - báo hiệu 
tệp đầu tiên có tên Document gặp lỗi khi in (Error- có sự cố). Theo trạng thái này chúng ta sẽ 
thấy xuất hiện hộp thoại báo sự cố xuất hiện. 

 
Việc cần phải làm trước khi nhờ đến các chuyên viên kỹ thuật đó là kiểm tra máy in có thật 
sự sẵn sàng in hay chưa gồm kiểm tra nguồn điện, dây nối giữa máy in với máy tính. 
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Thao tác với thực đơn lệnh Print 

Nhấn chọn thực đơn lệnh Print trên cửa sổ quản lý in làm xuất hiện hộp lệnh 

 
Các mục lệnh cần dùng đó là: 

* Set as Default Printer: đặt máy in đang sử dụng là máy in ưu tiên.  

* Printing Preference: mở hộp thoại để đặt lại các chọn lựa cho việc in 

* Pause Printing: đặt trạng thái tạm ngừng in hoặc hủy bỏ trạng thái tạm ngừng đã có 

* Cancel All Documents: thực hiện xóa bỏ một hoặc tất cả nội dung văn bản đang chờ in. 
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Các chương trình tiện ích 
Nghe nhạc từ đĩa CD 
Để sử dụng được các tính năng đa phương tiện của Windows, máy tính của bạn phải có vỉ 
âm thanh, loa, ổ CD-ROM.  

Nhấn chọn nút Start -> Programs -> Accessories -> Entertainment -> CD Player để mở 
chương trình . 

 
Giao diện chương trình 

 
Giải thích 

Nút Mô tả 

 Nút Play - nghĩa là đọc và biểu diễn nội dung. 

 Nút tạm dừng biểu diễn  

 Nút ngừng biểu diễn. 

 Dời đến đầu rãnh (bài)trước hoặc sau rãnh (bài) hiện hành. 

 Nhẩy lùi lại hoặc tới trước. 

 Đưa đĩa CD ra phía ngoài ổ đĩa. 

Thực hành: Đưa đĩa nhạc VCD vào ổ đĩa CD và nhấn nút Play  

Chương 

5
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Chương trình vẽ hình - Paint 
MMởở  cchhưươơnngg  ttrrììnnhh  PPaaiinntt    

Nhấn chọn nút Start-> Programs->Accessories->Paint để mở cửa sổ chương trình Paint. 

 
 

Hộp công cụ 

 

Công cụ Free Form Select (Chọn dạng tự do) để chọn một mẩu 
cắt có hình dạng không đều. Mẩu cắt là một vùng chọn mà bạn có 
thể cắt, chép, dời chuyển và xử lý theo nhiều cách khác nhau. 

 Công cụ Select (Chọn) để chọn một mẩu cắt tứ giác. 

 
Công cụ Eraser (Tẩy) để tẩy xoá từng phần của một đối tượng  

 
Công cụ Fill with Color (Tô mầu) để tô các hình khép kín. 

 
Công cụ Pick Color (Gắp mầu) để thay đổi mầu mặt tiền hay mầu 
mặt hậu cho khớp với mầu trong một phần khác của bức hình. 

 
Công cụ Magnifier (Phóng đại) các phần của bức hình. 

 
Công cụ Pencil (Bút chì) để vẽ các đường kẻ dạng tự do. 

 
Công cụ Brush (Chổi sơn) để vẽ các đường kẻ dạng tự do bằng 
các loại chổi vẽ khác nhau. 
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 Công cụ Airbrush (Bình xịt) để tạo các hiệu ứng “sơn xịt”. 

 
Công cụ Text (Văn bản) để bổ sung các văn bản vào bức hình. 

 
Công cụ Line (Đường kẻ) để vẽ các đường thẳng. 

 
Công cụ Rectangle (Tứ giác) để vẽ các hình chữ nhật và hình 
vuông. 

 
Công cụ Ellipse (Ê líp) để vẽ các hình êlíp và hình tròn. 

 
Công cụ Rounded Rectangle (Tứ giác chuốt góc) để vẽ các hình 
chữ nhật và hình vuông có góc chuốt tròn. 

  
TThhựựcc  hhiiệệnn  ttạạoo  ttệệpp  ảảnnhh  

(1) Nhấn chọn thực đơn File -> New 

(2) Sử dụng các công cụ vẽ để vẽ một hình tùy chọn.  

(3) Thực hiện sao lưu tệp ảnh bằng cách nhấn chọn thực đơn lệnh File->Save. 

CCắắtt  vvàà  xxửử  llýý  ảảnnhh  mmàànn  hhììnnhh      
Bước 1: mở màn hình nền hay cửa sổ bất kỳ, nơi chúng ta thấy rõ đối tượng cần được cắt 
ảnh. Nhấn phím Print Screen. 

Bước 2: mở cửa sổ chương trình Paint và nhấn chọn thực đơn lệnh Edit -> Paste. Nếu có hộp 
thoại xuất hiện, chúng ta nhấn nút Yes. Chúng ta sẽ thấy ngay hình ảnh được cắt trong vùng 
sọan ảnh của Paint. 

Bước 3: Dùng công cụ cắt hình để chỉnh lại khuôn dạng ảnh. Cuối cùng nhấn nút Save để cất 
giữ ảnh lên đĩa. 
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Nén/giải nén tệp tin  
Chúng ta có thể nén các tệp tin thành một tệp tin có kích thước nhỏ hơn tổng kích thước của 
các tệp tin, nhưng khi giải nén chúng ta lại được các tệp tin ban đầu, không có mất mát dữ 
liệu. Điều này đặc biệt có ích khi chúng ta tiến hành trao đổi dữ liệu qua mạng Internet và 
qua những đường truyền mạng máy tính có tốc độ thấp. 

Ngoài ra tiện ích về giảm dung lượng truyền dữ liệu, việc nén dữ liệu cho phép chúng ta gộp 
nhiều tệp tin đang ở trong nhiều thư mục con khác nhau thành một tệp tin duy nhất có phần 
mở rộng là .ZIP. Điều này rất tiện khi thực hiện trao đổi cho nhau các tệp tin. 
NNéénn  ttệệpp  ttiinn  

Chúng ta bắt đầu thao tác nén dữ liệu trên các tệp tin mẫu được đặt trên màn hình nền gồm: 
một tệp tin tên là vanban1.txt và một thư mục tên là congvan có chứa tệp vanban2.txt 

 
Thực hiện nén các tệp tin gồm vanban1.txt và vanban2.txt thành một tệp tin có tên là 
nen1.zip. 

Bước 1: Chọn thư mục congvan và tệp vanban1.txt 

Bước 2: Nhấn chuột phải làm xuất hiện hộp thoại và chọn mục lệnh Add to Zip làm xuất 
hiện hộp thoại WinZip. Sau đó bấm nút I Agree để làm xuất hiện cửa sổ thực hiện nén tệp. 
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Bước 3: Khi hộp thoại Add xuất hiện nhấn vào nút New làm xuất hiện hộp thoại cho phép 
nhập tên tệp nén. 

 

 
Nhập tên tệp vào ô nhập của mục File name. Ngoài ra chúng ta cũng có thể chọn lựa nơi 
chứa tệp là Desktop, ổ đĩa C hay  một thư mục con bất kỳ khác,... Nhấn chọn OK để thực 
hiện các yêu cầu đã lựa chọn và đóng hộp thoại New Archive trở về hộp thoại Add.  

Bước 4: Cuối cùng là nhấn nút Add để hoàn tất việc tạo tệp nén. Chúng ta nhìn thấy cửa số 
kết quả xuất hiện. Đóng cửa sổ bằng cách nhấn nút x hoặc nhấn chọn File->Exit.  

 
GGiiảảii  nnéénn  ttệệpp  ttiinn    

Khi có được tệp tin gửi đến dạng tệp tin nén .Zip, chúng ta thực hiện giải nén để có được 
những tệp tin bình thường. 

Bước 1: Nhấn đúp chuột lên tệp tin nen1.zip làm mở cửa sổ Winzip. 
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Bước 2: Nhấn nút Extract   có trên thanh công cụ của cửa sổ làm xuất hiện hộp thoại 
Extract. 

 
Trong hộp thoại Extract, nhấn chọn thư mục - nơi chứa các tệp tin được giải nén hoặc nhấn 
nút New Folder để tạo thư mục mới chứa tệp tin được giải nén. Kết thúc công việc bằng việc 
nhấn nút Extract. 

Kết quả: Trong thư mục chứa các tệp tin giải nén có chứa một tệp tin có tên là vanban1.txt và 
một thư mục con tên là congvan chứa tệp tin vanban2.txt.  

Virus máy tính 
Virus máy tính là các chương trình có dung lượng không quá lớn, được lập trình sao cho có 
thể lây lan từ máy tính này sang máy tính khác (thông qua các đĩa chương trình hoặc đường 
mạng), có thể làm ngưng trệ hoặc phá hỏng hệ thống máy tính.  

Cách thức phòng chống  

- Cài đặt chương trình phòng chống Virus cho hệ thống và thường xuyên cập nhật các bản 
nhận dạng virus. Máy tính có cài đặt chương trình quét/diệt virus sẽ làm giảm thiểu khả năng 
bị virus tấn công và phá hỏng dữ liệu đang có trên máy. 

- Thực hiện việc quét virus trước khi thực hiện việc sao chép các tệp tin từ thiết bị bất kỳ 
chứa dữ liệu: đĩa mềm, ổ đĩa cứng, đĩa CDROM ,... có trên các máy tính khác hay qua mạng 
máy tính. 

Quét và diệt virus trên máy tính  

Các chương trình quét/diệt virus hiện nay cho phép đặt chế độ tự động quét mỗi khi bật máy, 
quét vào một giờ cố định trong ngày và tự động bảo vệ hệ thống mỗi khi có sao chép dữ liệu 
vào máy tính.  
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Thực hành sử dụng chương trình Norton Antivirus của hãng Symantec:  

(1) Nhấn chuột lên biểu tượng chương trình  ở góc dưới bên phải màn hình nền hoặc 
nhấn chọn thực đơn    

Start->Programs-> Norton Antivirus Coporate Edition -> Norton Antivirus Coporate Edition 

 
(2) Nhấn chọn mục Configure -> File System Realtime Protection ở vùng bên trái.Nhấn 
chọn ô Enable File system realtime protection ở vùng bên phải để đặt chế độ luôn tự bảo 
vệ máy tính khi có thao tác sao chép dữ liệu. 

 
(3) Để thực hiện quét và diệt Virus, nhấn chọn mục Scan Computer ở vùng bên trái và nhấn 
chọn ổ đĩa muốn quét/diệt virus ở vùng bên phải. Nhấn nút Scan để bắt đầu quét Virus. 
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(4) Cửa sổ báo hiệu tệp tin bị nhiễm Virus sau khi thực hiện quét/diệt  

 
Chương trình tự động sửa chữa các tệp tin, cô lập các tệp tin bị nhiễm virus mới . 

(5) Nhấn nút Exit để đóng cửa sổ chương trình. 

 

 


